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INTRODUCTION

Technical Support

For technical support, contact Hochiki America at 800.845.6692 or technicalsupport@hochiki.com. Hochiki
technical support is available Monday through Friday, 7:00AM to 5:00PM, PST.

Prior to contacting technical support, have the following information available:

= Product part number

m Purchase order or order number
= Product serial number

= Current function of the product

= Expected function of the product
= Installation of the product

Return Material Authorization (RMA)

Contact Technical Support to obtain an RMA for any product to be returned. Returns will not be accepted
without an accompanying RMA number. An RMA number is assigned when:

« Tech Support acknowledges a possible product failure.
« A product was damaged during shipping

« Anincorrect product was shipped

« Anorderwas placed using an incorrect part number *

« Anorder was placed using an incorrect part quantity *

« Anorderis no longer required *

* Restocking fees may apply.

All returned products are tested to confirm operating failures experienced in the field. If the product is found to be
functional, contractors must absorb expenses for return shipping, as well as the cost and shipping of the
advanced replacement product.

Prominently display the RMA number on all packages sent for return. Ship all return products to:

Attention: RMA #

Hochiki America

7051 Village Park Drive, Suite 100
Buena Park, CA 90621

Warranty Service

Technical Support can replace or repair a defective product when the original purchase is within the warranty
period defined in the sales contract. Check the contract for more information, or contact your sales
representative about your specific warranty period.

Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
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Advanced Replacements

Products that fail to operate in the field can be replaced quickly using the advanced replacement process. The
advanced replacement process is available to all contractors who maintain an acceptable line of credit.

Initiate the advanced replacement process by requesting an RMA number from a Tech Support representative.
Advanced replacements can be shipped to your location when the product is covered under warranty and when
a replacement product is in stock.

« Advanced replacements can be expedited at the request of the contractor. Shipping costs associated with this pro-
cess are the responsibility of the contractor.

« Products returned using the advanced replacement process must be received within 30 days of the RMA issue date.

Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
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INSTALLATION

IMPORTANT! A Media Gateway panel module (S788) or K6012 Interface Card is required to use the L@ti-View
software. These cards only support connections to one computer or workstation.

For information on installing and configuring a Media Gateway panel module, refer to the following documents.
- Media Gateway Panel Module (S788) Information Guide
- Media Gateway Panel Module (S788) Functionality & Configuration Guide

L@ti-View works with

o L@titude

o Compas

o FireNET

o FireNET Plus
« Elite

. Elite RS

Installing the L@ti-View application also installs Openfire© instant messaging and PostgreSQL®© database
software as dependencies.

NOTE L@ti-View is supplied as the application and its dependencies only. Customers must supply their own data
for use with the L@ti-View software. This data can be from a previously created project, or it can be created by using
the L@ti-View design feature after installation.

The install wizard is restricted to repairing or removing L@ti-View if legacy artifacts are found during the install.
Remove the artifacts to perform a clean install.

The latest L@ti-View user guides can be downloaded from the VES Fire Detection Systems website.

System Requirements

These are the basic requirements for installing L@ti-View on a PC.

— Minimum Requirement Recommended Requirement

Processor Intel® Pentium™ P4 32 bit CPU Intel® Core™ i5 64 bit CPU

RAM 4 GB 16 GB

Hard Drive Size 120 MB 500 MB

Display 800 x 600 1280 x 768

Internet Connection Internet connectivity is necessary to perform updates and to take advantage of some features.

USB Port USB 1.0 port USB 2.0 port

Operating System Windows 7 Pro 32 bit Windows 7 or 10 Pro 64 bit

Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
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Installing L@ti-View

IMPORTANT! Administrator rights are required for L@ti-View installation.

NOTE Referto Repairing L@ti-View to troubleshoot any difficulties during installation.

Installing the L@ti-View application also installs Openfire© instant messaging and PostgreSQL®© database
software as dependencies. L@ti-View is supplied as the application and its dependencies only. Customers must
supply their own data for use with L@ti-View. This data can be from a previously created project, or it can be
created by using the L@ti-View design feature after installation.

1. Create a system restore point and back up all desired data before proceeding.

2. Export any current L@ti-View configurations before upgrading, repairing, or reinstalling.

3. Insert the L@ti-View installation USB drive.

4. Launch the installer and accept the UAC warning and the License Agreement.
NOTE The software will install in C:\Program Files\Hochiki (Windows 32 bit), or. C:\\Program Files
(x86)\Hochiki (Windows 64 bit). @

i

Choose or create a Start Menu folder (optional) and click Next.

Remove the dongle and click Install.

Wait for the software to install and perform the (license) Dongle Self-Test.

Click Finish to restart the PC and initialize the software and databases.

Click the L@ti-View desktop launch icon to start the application.

10. Consult with IT staff to configure L@ti-View to automatically start whenever the PC or Server is
rebooted.

© 0 N O

The L@ti-View Supervisor Service, Openfire, and PostgreSQL are set to start and run in the background when
the workstation is booted up. Do not disable these automatic starts as the L@ti-View 2D GUI must be able to
connect with them when it is manually started.

NOTE Automatic restarts should be considered where IT systems are not using Uninterruptible Power Supplies
(UPS) and are left unattended for any periods of time.

NOTE L@ti-View is designed to run permanently and cannot record or respond to any events if it is not running.

Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
L@ti-View Installation and Configuration Guide Page 9



fh HOCHIKI

Installation

Connect to a Fire Panel

IMPORTANT! Inthe Media Gateway settings, the MCE setting must be enabled in order to connect to a fire alarm
control panel. This can be done via the panel or LE2.

L@ti-View works with a number of different fire alarm control panel types. The following steps explain the panel
connection process.

1. Loginto L@ti-View using Administrator level credentials.

2. Click Fire Configuration in the System Configuration Menu (or from the main menu bar select View > Show Page

> Fire Configuration).

File | View Tools Help

& EB & 6 Normal Operation

®» D Fire Configuration Page

% plarm Config

HETERES = P (s U Set-up Connection to a Fire Panel

TR [3 Fire Configuration -

Y == Connect to panel
£ Account Management Panel Type:

Fire Configuration
Panel connectivity test
8 [ connectivity established. ]
3.

On the Fire Configuration page, select the Panel Comms tab, select the appropriate panel type and enter the

IP address of the Media Gateway. The Media Gateway Card IP address can be found by accessing the LAN (Local
Area Network) settings on the panel.

4. From the Panel Connectivity test, click Test to connectivity.

The computer should be configured with a static IP address in the same range as the target panel IP address.
Navigate to Control Panel > Network and Sharing Center on the computer or workstation where L@ti-View

is installed. Select Ethernet > Properties. View the properties of the Internet Protocol version and use an IP
address in the same range of that of the panels Media Gateway Card.

Importing Loop Explorer 2 Configuration Data

Itis necessary to import the fire alarm system configuration data into L@ti-View . The following steps detail the
process:

1. Loginto Loop Explorer 2.

2. From the File tab, select Export Graphix Data.

« Browse to the desired location on the computer.

« Name the export file by entering details in the File Name field.
« Select the radio button for Graphix (Version 2).

3. Click Save.

Hochiki America Corporation
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NOTE When importing from L@titude panels, the .xml configuration file can be used.

4. Returnto L@ti-View and select Fire Configuration from the System Configuration Menu. Select the
Fire Configuration tab.

5. Select Import..., browse to the save location of the LE2 configuration data file and click Open. The data will be
imported and will populate the Fire Configuration Page.

Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
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Repairing L@ti-View

L@ti-View and all its dependencies can be fully repaired, or incrementally repaired.

An unsuccessful L@ti-View-only repair can be repeated with Openfire and/or PostgreSQL selected. If this
second attempt fails, a complete uninstall/reinstall procedure should be performed.

NOTE Repairing L@ti-View causes the wizard to uninstall and reinstall the selected components. Ensure that
L@ti-View configurations and projects have been recently backed up or exported prior to executing the repair.

To repair L@ti-View using the installation repair tool,

Exit L@ti-View and remove the dongle.

Start the L@ti-View installation program.

Authorize UAC to change computer settings.

Select Repair and click Next.

Select the dependencies to include in the repair and click Next.

Ensure the details are correct and click Repair.

Wait until the uninstall is completed, check that the dongle is removed and click Install.
Select one of the options below and click Finish.

Nk

NOTE The repair procedure does not verify the dongle. However, an out of date or faulty dongle will prevent logging
into L@ti-View.

Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
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Uninstalling L@ti-View

Use the L@ti-View Installation software removal tool to uninstall L@ti-View and its dependencies. Do not
uninstall Openfire or PostgreSQL if they are used by other programs or if L@ti-View will be reinstalled with the

same configuration settings.

NOTE Print or save all reports, and save or export the current project prior to uninstalling any software.

To uninstall using the installation software,

1. Exit L@ti-View.
2. Runthe L@ti-View installation program.
3. Select Remove and click Next.

Lati-View Program maintenance
Repair, or remove the Lati-View program.

) Repair
‘:" d Repair errors in the program. This option fixes missing or corrupt files,
ﬂ shortcuts, and registry entries.

@ Remove
l-zj Remove the program from your computer.
¥

4. Select the check box to remove all configuration and program data and click Next.

Version 1.00 | May 2020 | MAN-1443HA
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Lati-View Remove Program Data
Remove Lati-View configuration and program data page.

—
i Remove all Lati-view configuration and program data

< Back ][ Mext = ][ Cancel

5. Select whether to remove KEYLOK, Openfire, and PostgreSQL, and click Next.
-
Setup - Lati-Vi = X

Optional Packages Uninstall
Optionally uninstall third party packages assocated with the Lati-View software.

Flease select the third party packages you wish to remove as part of this uninstall.
Click next to continue.,

KEYLOK (usbkey) USE
Openfire 3.8.1

PostgresgL 8.4

< Back “ Mext = ][ Cancel

Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
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6. Onthe next screen, click Uninstall.
7. Reboot the computer or workstation to finish the uninstall.
8. Confirm that the following software has been removed:

« ASL Patched OGRE

« ASL Qt Express

« Keylok Driver (Windows 7) (option)

. L@ti-View

o Openfire

« PostgreSQL

« Windows Driver Package - KEYLOK (Windows 10)

Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
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ACCOUNTS AND ACCESS

L_@ti-View Dongle

A valid license USB license dongle must remain in
place for the duration of the L@ti-View session. Its
removal will prevent additional logins and will disable
L@ti-View after a period of time. The USB dongle is
encrypted and contains a license for one machine only.
It must remain installed for the 2D GUI to continue
running. USB license dongle

L@ti-View and its dependencies will run in the background. Log in with an appropriate user account and
password to interact with the software, acknowledge alerts, silence buzzers, etc.

Default User Accounts

L@ti-View is supplied with four levels of default user accounts and passwords, which should be changed
following the software installation. The default accounts and passwords are case sensitive and are:
Administrator admin

Maintainer maintainer
Manager manager
Operator operator

Itis advisable to have at least two Administrator accounts, as lower levels cannot change passwords or account
details for higher levels.

NOTE Three incorrect tries will lock L@ti-View for 60 seconds. All login attempts (successful or failed) are time-
stamped and recorded in the Event Log.

Logging In and Out
Log In

Tolog in, enter the appropriate credentials in the Log In window.

Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
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ra 4
oy B

Log In

£\ Username

» Password

L A

Log Off and Exit

Only alogged in user with Administrator level access can close (exit) L@ti-View safely. Using any other method
(e.g., Ctrl-Alt-Del) could result in software corruption or loss of data.

1. Tolog out, click the Log Off icon in the toolbar, or File > Log Off.

2. To exit, click File > Exit.

User Groups

There are four default User Groups plus optional custom user groups, and each group can be assigned with
custom User Group tokens that are used to grant or deny access to specific L@ti-View components. This table is
a guide, but Administrators can create customized user accounts or access levels to match their own
requirements.

3 3 2 1
Task !
SysAd Maint. | Manager | Operator
Yes Yes Yes Yes Yes

Log In

Fire maintenance functions Yes Yes Yes Yes No
Access operational procedures Yes Yes Yes Yes No
View Active Events Yes Yes Yes Yes No
View Active Fires Yes Yes Yes Yes No
View Cause and Effect Strategy Yes No No No No
Poll Device Analog values Yes Yes Yes No No
Manual refresh device status Yes No No No No
Disable / Enable Devices Yes Yes Yes Yes No
Disable / Enable Zones Yes Yes Yes Yes No
Acknowledge Events Yes Yes Yes Yes No
Acknowledge Fire Events Yes Yes Yes Yes No
Manual Evacuation Yes No No No No
Reset Fire Devices Yes Yes Yes Yes No
Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
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3 K} 2 1
Task .
SysAd Maint. | Manager | Operator
Yes Yes Yes Yes No

Silence Alarms

Silence Buzzer

System Alarm Acknowledgment
System Alarm Unacknowledgment
Local alarm (PC) volume control
Clear Hard Troubles

Disable / Enable Alarm Reporting
Clear Alarms

Find Mode

Select Mode

Fire System Topology View

Export tables

Generate Reports

View Historical Events

View Maintenance Log

Fire Mode in 2D GUI

Fire configuration

Fire simulation mode

View System Information page
View Fire Management GUI
Operate/Restore Outputs

Save Column Widths

Change Own Password

Account Management (Edit/Create/Delete users)
Database management and editing
Workstation Configuration

Use 2D Editor mode

Exit L@ti-View

Change User Passwords

Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes

Yes

1. Loginto L@ti-View with an appropriate account level.
2. Click Account Management from the System Configuration Menu, select a user name (or add a new one), and

select Change Password.
3. Enter the required details and click OK.

Hochiki America Corporation

L@ti-View Installation and Configuration Guide

Yes
Yes
Yes
Yes
No
No
No
No
Yes
No
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
No
Yes
No
Yes
Yes

Yes

Yes
Yes
Yes
No
No
No
Yes
No
Yes
No
Yes
Yes
Yes
Yes
Yes
No
Yes
Yes
Yes
No
Yes
No
No
No
No
No
No

Version 1.00 |

Yes
Yes
Yes
No
No
No
No
No
Yes
No
Yes
No
Yes
No
Yes
No
Yes
Yes
Yes
No
Yes
No
No
No
No
No
No

May 2020 |

No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
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@ B & om Normal Operation

@ pYetid Account Management

£ Alarm Config 8 vancg &

womses || [0 [

f1 Archiving T Description Full Name

& LS Administrator Company
£ Account Management. Description
Maintainer

& FireConfiguration " Password (5] Change Password
anager

(@ Workstation Config Enabled
Operator [

| [ shom assigned items oniy

[ show password

((2Jimport | [ &) export | [ZsRefresh | [ @yadd | [ 2 clone | [ @pekete

Logged on as: Administrator Workstation ID: box01a Orline 5/25/2020 4:58:00 PM

System Administrators should decide if they want to use individual user accounts, or role-based user accounts
with shared passwords, or a mixture of the two. Individual accounts are more secure than shared accounts and
can be used to control or block access by individuals, whereas a shared operator account might be useful in
locations where L@ti-View runs constantly.

All users must manually log off at the end of their session. All log in, log out, and exit events are time stamped in
the Events log. Failure to log off could allow another user to perform unauthorized actions.

Change Individual Password

Click File > Change Password... and enter the desired details in the Change Password window.

Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
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-

{31 Change Password

? |

Change

Password

£\ Username
Old Password
» Mew Password

; Mew Password {confirm)

Administrator

Change Password

] [ Cancel

Hochiki America Corporation
L@ti-View Installation and Configuration Guide
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GUI OVERVIEW

The L@ti-View interface is highly editable, and therefore may not look exactly as shown. L@ti-View gives
building managers complete monitoring and control over fire detection, providing a comprehensive fire risk and
incident management system.

File View Tools Help

&> En @ Normal Operation

@ D6 Knole Building

#  alam Config e Contrel Mode

- memsaus | e

5 Achiving Level0
Level +1

Lid LS Level -1
BiAccountMenagement| | Level 2
& Fre Configuraton

@ werkstaton Config

M

I G TR §

i Svofomin Yy At R |

.2 0

[LLLE LT T X

Displayed Zone Type:| Detection Zone  +

Fire Mode

Projectioaded. |

Logged on as: Adrinistrator. Workstation ID: box01a Orline 5/21/2020 2:48:00 PM

GUI Menu

File

o Log Off
« Change Password...
« Exit

o Show / Hide Main GUI [F5]
« Show Home Position

« Show Page >

« Save Settings [Ctrl + S]

« Alerts Volume

Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
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Help
« About

Toolbar Icons

Log Off

Toggles between the current Configuration and the Home Screen
Show Home position

Search

& E-BLE

System Configuration Menu

The System Configuration menu is located on the upper left-hand side of the GUI. The System configuration
menu displays account-specific options. Detailed information regarding configuration options can be found later
in the document.

) 2D GUI

d ] Alarm Config

Alarm Status
Lall Archiving
& Fire
&'Acmunt Management

¥y Fire Configuration

(&) Workstation Config

Control Mode

Control Mode The Control Mode tool bar is located in the main section of the interface, when
in the 2D GUI tab.

| select || ¢ Fire

Select Select Mode allows navigation of the GUI via menus, buttons, hotspots, and
macros.

Fire Fire Mode allows the user to filter the results by:

Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
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« Detection Zones
Evacuation Zones
Operational Zones
Manual Evacuation

When there are active events on the system, a box will appear in front of the GUI providing information about that
event.

File Yiew Tools Help

&b @Ee = Normal Operation
@ D 6U1 Level +3
£
o Alarm Config S Control Mode
©  Aamsiane Leve 32
B Achiving Level D
Level +1 5
& e Level -1 Fire
£ Account Management| | Level -2 Incident Time: 07:28:51
Detection Time: 5/25/2020 12:08:45 PM
Fre Configuraton ) -28:
= . DZone: Unknown 07:28:51

@ workstation Config

Device: Unknown
Panel: Unknown Loop: Unknown

Location: Unknown B3

4’.

A"

NV

[selct e Unsaved changes,

Logged on as: Admiristrator Workstation ID: box01a Orline 5/25/2020 7:37:00 PM

Editor Mode

The Editor Mode toggle button is located on the main section of the interface in the lower left section. Detailed
information about editing options can be found later in this document.

E.

Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
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2D GUI EDITOR MODE

L@ti-View’s editing mode can be used to design or edit site plans using a variety of shapes, texts, function
buttons, and macros. The editing mode also allows creation or editing of item and plan level properties via panels
and sub-menus (Some fields may have been pre-populated by the New Project wizard, but they can be edited if
required).

Project Navigator Panel 8 x

[:] [ Levels | «ff symbols | [ Object Model Sidebar

=
)

uuuuuuu

Properties Panel | _Fifter Ttems Panel

Editor Mode No project loaded,

All panels are visible and docked by default when Editor mode is first opened, but can be dragged, floated,
minimized, or closed as required. Toolbars are horizontal or vertical, depending on their location. L@ti-View
saves previous choices until the next session. However, Editor preferences can be saved using View > Save
Settings.

Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
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2D GUI Editor Mode

Toolbars

Primary Editing Toolbar

The GUI Editor Primary Editing toolbar (across the top of the GUI) contains standardized icons that can be used
to apply various actions to selected items. Every icon has a hover tooltip for easy identification.

|_| NEW PROJECT ]
OPEN PROJECT & |

' RESTORE PROJECT

=

[= SAVE PROJECT =
-, SAVE PROJECT VERSION .
5 RELOAD PROJECT =
2l EXPORT PROJECT -
@ CUT il
L] coPY =
PASTE m

2 UNDO 2
' REDO 2

., GROUP SELECTED ITEMS
2% UNGROUP SELECTED ITEMS
LOCK SELECTED ITEMS

UNLOCK SELECTED ITEMS

" SEND SELECTED ITEMS TO FRONT =
| SEND SELECTED ITEMS TO BACK
“* MOVE SELECTED ITEMS FORWARD

=/ MOVE SELECTED ITEMS BACKWARD

Hochiki America Corporation
L@ti-View Installation and Configuration Guide

VERTICAL ALIGN TOP
VERTICAL ALIGN CENTER
VERTICAL ALIGN BOTTOM

HORIZONTAL ALIGN LEFT
HORIZONTAL ALIGN CENTER
HORIZONTAL ALIGN RIGHT
SIZE SELECTED ITEMS TO THE

SAME WIDTH AS THE FIRST ITEM

SIZE SELECTED ITEMS TO THE
SAME HEIGHT AS THE FIRST ITEM

DISTRIBUTE SELECTED ITEMS VERTICALLY

DISTRIBUTE SELECTED ITEMS HORIZONTALLY

ZOOM IN
ZO0OM OUT

RESET ZOOM
TOGGLE GUIDES DISPLAY
TOGGLE GRID DISPLAY

EDIT SYMBOL LIBRARY SETTINGS

EDIT PROJECT SETTINGS

TOGGLE ALARM FLAG PLACEHOLDER VISIBILITY

Version 1.00 | May 2020 |
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Toolbox Toolbar

The Toolbox toolbar (down the side of the GUI) provides standard drawing tools that are used to add items to the
currently displayed level. Each tool may provide additional editor functions that will be displayed in the Active
Tools actions toolbar. Each icon has a hover description, and the editor status bar (at the bottom of the screen)
displays the active tool's name.

D SELECT AND EDIT ITEMS Enables point and click to select items or groups.

Opens the Text toolbar and enables point and click text insertion. Text can be edited for Font,

o ADD TEXT ITEMS F?]nt size, IBollzi,(;talic, or Underline, RGB Color, and Background type. Inserted text can be edited
when not locked.

Ll ADD RECTANGLE ITEMS Adds rectangle shapes to the image.

= AD D ELL| PSE |TEM S Adds ellipses and circles that can be edited, overlapped, or cut to make other shapes or callouts.

& ADD REGULAR POLYGON ITEMS Adds regular polygons that can be rotated and edited.

Peg Adds freehand polygons by clicking to define freehand points and lines. The fill style adds

bt ADD POLYGON ITEMS shading between connected points, and shapes can be overlaid to show 2D-relief styles.

nf ADD LINE ITEMS Adds straight lines at any angle. Lines can be edited for color, weight, and axis.

Pl AD D ZON E ITEM S Allows you to freehand draw Detection Zones, Evacuation Zones, and Operational Zones, which

become shaded as you draw. Different zones can overlap.

Bl 5

Allows you to freehand draw hotspots, which become shaded as you draw. Different hotspots
ADD HOTSPOT ITEMS can overlap. " Y ’

ADD NAVIGATION BUTTONS This tool adds pre-defined navigation buttons (with optional icons) at your chosen locations.

[

AD D MAC RO B UTTO N S This tool adds pre-defined macro buttons at your chosen locations.

=]

Tool Options

The context sensitive toolbar may be blank, or it may display additional controls for the selected tool. All individual
tool options are shown below.

Select and Edit Items

Selecting overlapping polygons will open an additional toolbar that will allows merging or transecting the selected
objects.
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MINUS BACK
MINUS FRONT
MERGE
INTERSECTION
D &0 E

ﬁgu&z;/i}-"HEIE
StrokeStyle [Soid | 1 % (M

Fill Style |Solid ~|
Tool Description
Minus Back Subtracts the objects in back from the frontmost object.
Minus Front The frontmost objects will be cut out from the back-most object.
Removes the part of a filled object that is hidden. Removes any strokes and merges any adjoining or
Merge - . i .
overlapping objects filled with the same color.
Intersection Traces the outline of the region overlapped by all the objects.

Add Text Items
s(a]lm ® a B /B EEE

Font MS Shell Dig 2 v Size: 8Pt [T @

Color |§|
Background Mone - ] Ii'

Add Rectangle Items
s A(m]® A B /B e EE
swokesvie (si___v] 1 2] M

Fill Style [Nune - ] Ii'

MAN-1443HA
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Add Ellipse Items
Agfelap /s rEEE
swokeste [sad___+] 1 2] M

Fill Style [ None Ml |

Add Regular Polygon Items
Amoefalp /¢ 5 E E

Fill Style [ None ~

Points & B

Add Polygon Items
,Ame Alf]/ F HEE

Fill Style [ None ~| W

Add Line Iltems

aq-_'&Z}EZ&EE
StrokeStyle [Soid | 1 2 (M

Start Cap [Nune - ]
End Cap ’Nnne - ]
Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA

L@ti-View Installation and Configuration Guide Page 28



‘I® HOCHIKI] 2D GUI Editor Mode

Add Zone Items

s A B e AR /|FEEBE

Zone type |Detection Zone -
Detection Zone

Evacuation Zone
Operational Zone
PA Zone

Add Hotspot Items

v AE® AR/ RHEB
svoke sy [Dohordor v 2 2]

Fill Style [Cmss - ] D

Add Navigation Buttons
AE® ap /s R EEE

Font MS Shell Dig 2 ~ Size: @pt (= [E]

Icon [

Mo Icon - l

Accessory Icon

2 right_arrow_alpha.png -
@ house_go.png -
@ information.png

o~ key.png

@l layers.png

€ left_arrow_alpha.png

&' lightbulb.png (Wl

&' lightbulb_off.png il
lightning.png

& |ink.png

‘1 lock.ona i

Add Macro Buttons
s A H ® AN/ FEEBMN

Font MS Shell Dig 2 v Size: 8Pt [T @
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Project Images

Before creating a new project, it is important to understand how the software organizes the operational part of
the project.

Create and assemble all necessary project images before starting a new project. This may already have been
done if L@ti-View was installed on other machines and the project was saved to a server. To access the saved
project, click Open Project and load the project data.

Images, symbols, and icons are imported at 1:1 resolution. Resize them as desired before changing their
settings. L@ti-View supports most image types, but *.png sized at 9 x 9 mm are recommended for consistency
and clarity.

When importing background images, choose between scaling them to fit on screen or moving them around the
screen using slider bars.

When saving projects and resources, save them to a backed-up server where they can be accessible from other
workstations.

Image Types

Create and save:
« One image of the site or building for the Home page level
« Site and/or individual floor plans for the additional levels
Supported image file types are .bmp, .gif, .jpg, .jpg, and .tif.
Level images should be approximately 2000 pixels wide 1000 pixels wide (150 dpi).

NOTE When creating a new project, a selection of commonly used symbols are found within the symbols folder.

Saving Images and Icons

L@ti-View creates and populates a basic project folder, but it is possible to manually create and populate a
project folder.

Save symbol images in the user folder. Additional folders can be created anywhere within the parent folder; e.g.,
a separate ‘levels’ folder may be desired for site and floor plans.

x-y Coordinate System

The 2D GUI uses the standard x-y screen grid where the point of origin is the top left corner, and the item
coordinates are its center point. Object center coordinates can be offset to avoid conflicts with adjacent items.

Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
L@ti-View Installation and Configuration Guide Page 30



‘I® HOCHIKI] 2D GUI Editor Mode

oo

x - AXIS

< x

Fire Symbeol

*® 52
y: 22
w: 50
h: 50

y - AXIS

Z - Index

The 2D GUI uses a virtual-layer system for ordering items according to their priority. These layers are achieved
because L@ti-View automatically creates ‘z-axis’ depth bands (the Z-index) as items are being added in Editing
mode.

The background image layer will always be the lowest layer, and higher priorities will always be displayed on top
of lower priorities, as shown.

CONTROL MODE HUD LAYER

ALERT FLAGS LAYER

SYMBOLS LAYER

ZONES LAYER
BACKGROUND IMAGE LAYER

While an item’s Z-index can be manually altered in Editing mode, this is not recommended as it could adversely
affect other items and alert flag priorities.

NOTE Layers are different than levels. Levels are equivalent to floors in a building, while layers refer to where an
object is ordered on the z-index.
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Project Navigator Panel

The Project Navigator Panel has tabs that provide quick access to the current project levels, symbols, and
subsystem object tree information.

Levels Project Mavigator Panel g X
« Seethe current plan level levels | < Symbols | IS ObjectModel | — sidebar |
« Select and view another level in the background
Level +3 [
 Add orremove plan levels g T
[ i i

« Editaplanlevel’s properties and image
Levels that have been edited, but not saved, are highlighted
in pink.
The level being viewed and selected for editing are
highlighted in blue.

_-i Level +2

Level +1

=| Level -1

e Level -2 =

[ E Add ][ E Remove ][‘__9},. Level Propert'es]

Symbols Project Navigator Panel 8 x
[F]Levele | < symbols | [ Object Model Sidebar
« Drag and drop pre-defined symbols onto the selected level Bt synbel ey setings: )
« Edit the symbol libraries (import or delete symbols) & e _
@27 O ® ) L | ss)| 2| @) | 20| B | 5]
D25 & | e | |E] ¢ | @S] & |-
0|58 = =] 0 =) B
°|EEE -
55 wser -
Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
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2D G

Ul Editor Mode

Object Model

« Select a sub-system to view

« View Object Model paths in expandable tree view

« View the Equipment List by item Name and JPC Path
« Hide or show items

« Highlight orphaned items

Sidebar

« View the plan levels that appear in the Sidebar

« Rearrange the order of levels

« View unassigned plan levels

« Transfer levels between the unassigned and assigned lists

Project Mavigator Panel [
Levels 4 Symbols =) Object Model ‘ sidebar |
Select subsystem [ ¥ Fire - ]
= Object Tree -2 Equipment List | W PA Zones |
Q |
Path | Value | Location =
= 13| L@ti-View
5 Fi
boxlla
Config Mismatch
Fault
Fault
£5 Description  AUTO CONFIG..
45 FASID Mode 01
+- 57 Loops
££ Name L@titude
@ status Fault
£ status MNormal
=} 4% Zones
=t ;¢ Detection Zones
+t 2 DetZone0001 Zonel j
[Hide placed ibems][show all items Find unmatched placed items
Project Navigator Panel 5 X
| Levels | :@7 Symbaols | I[] Object Model | Sidebar |

NOTE The item moved to the top of the Sidebar tab’s
‘allocated’ list automatically becomes the L@ti-View Home
page, which will be indicated by the Home icon appearing on
that level.

Hochiki America Corporation
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Unassigned Levels

Sidebar Levels

Level 0-5

Warning - Level 0
Warning - Level1 ‘
Warning - Level -1
Warning - Level 2
Warning - Level 3
ZONE 001

ZONE 002

ZONE 003 [LEVEL +1]
ZONE 003 [LEVEL 0]
ZONE 003 [LEVEL -1]
ZONE 003 [LEVEL -2]
ZONE 004 [LEVEL +1]
ZONE 004 [LEVEL 0]
ZONE 004 [LEVEL -1]
ZONE 004 [LEVEL -2]
ZONE 005

ZONE 006 [LEVEL -1]
ZOME 006 TLEVEL -21

m

Level +3
Level +2
Level 0

Level +1
Level -1
Level -2

EIEY

ENE2

Version 1.00 |
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Properties Panel

The Properties Panel has tabs that allow the creation or editing of a selected item’s properties. All screen items
have properties that can be created or edited in the Properties Panel tabs. Some properties automatically
change when moving or resizing items manually. To view the properties of an item, select an item to be edited.

Explanations of the different properties are shown below, but the properties are context-sensitive and may not
be visible at the same time.

NOTE Property changes are disabled when selecting multiple items at the same time.

The Properties Panel supports drag-and-drop from the object model tab. The following properties can be
configured using either manual entry or drag-and-drop:

. JPC Path
. Name (JPCID)

Properties Panel =
.7 Base *. Appearance < Flags ', Troubles
) JPC Path
« JPC Path. The related subsystem equipment’s JPC path.
Mame Plotted Hotspat 3

« Name. The unigue name of the item or button.
« Description. Optional short description text displayed in Description
the item status information window. Location

« Location. Optional location name e.g. ‘Arrivals Hall’.

« Contains Path. Optional comma separated list of
additional subsystem JPC paths that drive the alert status
flag.

« Target. The location that L@ti-View will jump to when
clicking on the item or button.

Contains Path

Target knole_building -

Properties Panel Filter Items Panel
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2D GUI Editor Mode

Bounds

« X. The object’s normal centre point x-axis coordinate
(without offset).

« Y. The object’s normal centre point y-axis coordinate
(without offset).

« Width. The width of the item in pixels.

« Height. The height of the item in pixels.

Zindex. Measured in pixels, adjusting the values, the Y axis
changes the ‘height’ of the symbol. Symbols are allocated Z-
Index numbers in the order they are added, so it is possible
to stack a symbol on other symbols depending on their z-
index (e.g., a Sounder with index 100005 could sit on top of
BGU 100004 but would be below BGU 100007). This could
be possible where the user adds and defines a hotspot or
macro button, and afterwards adds and drags a symbol on
top of it for ease of identification.

Z-Index numbers can be manually edited, but this is not
recommended as it is not possible to know what numbers
are already in use or what may be used in the future. Itis
also not recommended to change the number of Os in a Z-
Index, as they control the z-layer alert priority bands (e.g., a
zone would be 100x whereas a symbol would be 10000x).

The Z-Index of the base layer image cannot be changed, as
it is always the lowest fixed level.

Offset

« X. The horizontal offset from the object’s center point to
the center of the displayed alert flag, in pixels. This can be
a positive or negative number, e.g. 50px or -50 px. For
zones, the polygon center is offset.

« Y. The vertical offset from the object’s center point to the
center of the displayed alert flag, in pixels. This can be a
positive or negative number, e.g. 50px or -50 px. For
zones, the polygon center is offset.

Drop Shadow. The alarm flag’s drop shadow can be on or
off.

Hochiki America Corporation
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Properties Panel =
iBase | = Appearance | i Flags | '\ Troubles |
Bounds R

EE®

T EE®

width 313 px [ZJ EJ @

Height 280 px E| EJ @J
Zindex 100003 =] (=] (8
Properties Panel Filter Items Panel

Properties Panel =

| .7 Base £ Appearance '.w_-_;'. Flags | ", Troubles |
Offset -

EE®
¥ -40 px T T @
Drop Shadow
Properties Panel Filter Items Panel
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Transparent. Specifies whether the object is transparent to  prgperties panel 5
troubles. Transparent objects still display troubles, but they [ Gigase | © Appesrance | < Fiags | /. Troubles L
are propagated to their parent entity. - :

Transparent [

Properties Panel Filter Ttems Panel

Version 1.00 | May 2020 | MAN-1443HA
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2D GUI Editor Mode

Filter ltems Panel

This panel allows the filtering of on-screen items, which can
be useful when there are a lot of screen objects displayed,
or when objects are affected by objects on different layers.

Items can be filtered by type or name. Use the torch icon to
select or deselect all items in the list.

To filter items,

Select the desired level in the Project Navigator.
Select the Filter Items Panel.

Select the desired filter tab.

Use the check boxes to select individual items.

o nN =

NOTE The Filter by name tab is context-sensitive and
will only show the items already included on that level.

Hochiki America Corporation
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Filter Items Panel

L4 Filter by type Al Filter by name

Detection Zone
Evacuation Zone
Fire Symhbal
Generic Symbaol
Hotspot

Line

Macro Button
Mavigation Button
Operational Zone
PA Symbal

PA Zone
Polygon

Text

| Properties Panel Filter Items Panel

Version 1.00 |

May 2020 |

MAN-1443HA
Page 37



2D GUI Project Settings '.r HOCKHIKI

2D GUI PROJECT SETTINGS

New projects always start with default settings, which can be edited, or reset to default, at any time. Click the
Edit Project Settings button.

Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
L@ti-View Installation and Configuration Guide Page 38



‘.c HOCHIKI 2D GUI Project Settings

General Settings

@ Project Settings B |-l

0 General settings }‘. Manitored Subsystems = Vendor Logic Rules | [=] change Log

Project Name

Project Path (o3}

Project Desaiption

Title Prefix

Scene size width —[} 1610 (D) Heght { ] 70 | (3
Default background color I:‘
'\ Flags Zones Preview

Size D 8 B @]

Offsetx [ 0 = @

Offsety D -0 @

Opadty [] 100 )

Attract animation duration (secs) D 5 @ LS

Drop shadow enabled

Drop shadow color D ‘

—
Drop shadow opacity D 0.70 D @]
[T Cydle zone states

J

The top of the window contains general information about the project. Any changes can be reset or cancelled.
The Project Name and Path are auto-filled. Enter the desired Project Description and Title Prefix. The
Scene Size measurements are in pixels.

The bottom of the window has two tabs - Flags and Zones.

The Flags refer to alert icons and their placement on the background graphics. The flag offset refers to the
center coordinate of the flag, which can be offset if concurrent flags are very close to each other.

The Cycle Zone States checkbox allows the preview image to cycle through the color states set in the Zone tab.

The Zones tabs contains a list of the alert states, each showing their default color overlay, which can be
visualized on the preview window. Each state has a drop-down box showing the alternative colors or cross-
hatching styles; e.g., visually-impaired persons might benefit from using cross-hatch instead of color overlays. A
slider provides the ability to control the opacity.
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CT B 5

ﬂ &u‘

.2 General settings | qj Monitored Subsystems | _i= Vendor Logic Rules | [=] change Log ‘

Project Name test_project

Project Path C:\Users\cgera\Desktop\VES Y atiView\test_project

Project Description

Title Prefix

Scene size width | 1610 (D) Heht ]

Default background color |:|

/v, Flags % Zones

0 (@)

Preview

07/ (€ &) @
’,//‘Blackstripes ']

Busy Mot Overridable -\ﬁolet - | Active
Error [,//‘ Red Stripes [ Pink - ]

BGM - Green - | Mute ’\\\‘ Green Stripes (Rev) - ]

Opadity ’ D

Quiescent state ’ Blank '] Fire state

Evacuation state

“ellow - ]

Test state ’ Yellow '] Selected state

VA Priority 1 Orange - ]

VA Priority 3 [ Yellow

w7 ] Listen In

ll PA Zone

[ Cycle zone states

Hochiki America Corporation
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Monitored Subsystems

The Monitored Subsystems tab lists the monitored subsystems in the network. These can be deselected if
required.

P

) Project Settings

4 General setings | & Monitored Subsystems | = Vendor LogicRules | (] Change Log

Select subsystems to meritor
Fire
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Vendor Logic Rules

The Vendor Logic Rules allows customized flags to be added or duplicated using JCOP/Openfire processing
rules. More information can be found on https://www.igniterealtime.org/projects/openfire/.

I (3 Project Settings l_I_H" e S|
.2 General settings y Manitored Subsystems = vendor Logic Rules | = Change Log

ITtem lookup rules

Rule’Nama JPC Path Reg Expr Info tem Value Item Type Symbel ‘m
ACA-E Multi Sensor Product 21614 Fire Symbol .% multi.bmp L
ACB-AS/ACB-ASW Heat Sensor Product 155184 Fire Symbaol =4 heat.bmp
ACB-E Heat Sensor Product 153.80 Fire Symbaol = heat.bmp
ACC Multi Sensor Product 248 167 Fire Symbaol L4 multi.bmp
ACD-V Multi Criteria Sensor Product 217.263 Fire Symbol .ﬂ multi.bmp
AIC/AIC Ion Sensor Product 16813 Fire Symbol E"“ ien.bmp
AIE-EA lonisation Sensor Product 168.24 Fire Symbaol = ion.bmp
ALE/ALG/ALK Phote Sensor Product 13611 Fire Symbaol L=4 photo.bmp
ALG-V Photoelectric Sensor Product 136.22 Fire Symbaol L=4 photo.bmp
ALK-V Photoelectric Sensor Product 250135 Fire Symbaol 1=4 phota.bmp
ALN Photoelectric Sensor Product 247168 Fire Symbol ,E"., photo.bmp
AMS Pull Staticn Product 699 Fire Symbol @ pullstation.bmp
ARB Relay Base Product 71172 Fire Symbaol 3 relay_modulebmp
AR!_%:I Relay Base Pro_duct 71173 Fire Symbaol _,;, relay_medulebmp  ~
] n »
[ & add ][, Duplicate ” J Delete ]

T

Click Add to add a new rule. The Define new item lookup rule window appears. Enter the desired rule
criteria.

(3 Define new item lookup rule B

Please spedify 3 JPCPath regular expression or data point name and value.

Rule Name
Data point name
Data point value

JPC Path reg expr

Item type [Fire Symbol - ]
Symbol [Nune - l
Priority 0 =

[] Keep dialog open

7o

Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
L@ti-View Installation and Configuration Guide Page 42



'.O HOCHIKI 2D GUI Project Settings

Change Log

The Change Log tab records all changes made to the project.

(3 Project Settings [ 7 [eSe
7 General settings .:J Monitored Subsystems :: ‘endor Logic Rules | = Change Log
Change Log:
DateTime User Comment
19/03/2715:03:59 | km Changed Node 8 Loop 1 Address 18
o
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CREATING A NEW PROJECT

1.

Inthe 2D GUI set to Editor mode and logged in as an Administrator, click the New Project button. The New Project

window appears.

Project Name. (Required) Enter a name for the
project.

Project Location. (Required) Click Choose and
browse to the desired save location.

Project Description. (Optional) Enter a description
for the project.

Title Prefix. (Optional)

Scene Size. (Optional) Type in the scene width and
height in pixels (default setting is the monitor
resolution). Choosing the wrong size will cause the
images to scale to the wrong size, which will create
sliders for moving the scene, but may also hide some
buttons and features off-screen.

NOTE Make the background size the same as the
image being inserted.

Default Background Color. (Optional) Click the
square button to select a background color. Itis also
possible to input RGB or HSV values.

2. Click Next. The Initial Level Images window will appear.
3. Toadd alevel image, click Add.
4. Browse to the location and select the desired image.

« Inthe Level Properties tab, enter the following information.

Name. Name level image (Optional).

Description. Give the level name a description
(Optional).

Background Color. Set a background color
(Optional).

Hochiki America Corporation
L@ti-View Installation and Configuration Guide

- Inthe Background Position tab, enter the following information:

@ Create New Project l D)
. New Project
- |
“IJ%  Please enter a project name and select a target location folder.
Project Name
Project Location C:\Jsers\cgera\Desktop \WVES \Latiview, Choose
Project Description
Title Prefix
i — —
I Scene size Width D 1920 LQI Height D 1280 L@
| Default background color l:‘
|
I
@ Create New Project [ 9 [
Initial Level Images
Please add any initial project level images
Level Images
Level Properties | Background Position
fl b
il MName
| Description
| Background Image
Background Color D
l @ add || @ Remove
I
' [= et
Version 1.00 | May 2020 | MAN-1443HA
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Creating a New Project

« Check Center background to center the image to
the scene (Optional).

o Check Scale to fit to uniform scale the image to
the scene (Optional).

« Click and drag in the preview pane to manually
adjust the image position within the scene.

NOTE Furtherinformation on image positioning
can be found in the following section.

@) Create New Project

Initial Level Images

Please add any initial project level images

Level Images

Level Properties | Background Pasition

5. Add more levels as required. To remove the level, select the desired level and click Remove.

6. Click Finish when done.

Hochiki America Corporation
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Project Levels

Levels can be attributed to floor levels in a building, rooms, areas, or zones, and can be configured to lead to
other targets with the aid of hotspots, macros, etc.

Levels can be assigned, unassigned, promoted, demoted, and assigned as the Home page by editing the Project
Navigator Panel’s Sidebar tab.

To Add a Level Image

1. Inthe Project Navigator Panel, select the Levels tab and click Add. The Import Levels window appears.

E‘ Import Levels l ? &J

Level Images
Level Properties Background Position

D

Mame

Description

Background Image
Background Color D

(2 Add | (& Remove |

OK 3 cancel

2. Click Add and navigate to the folder with the desired site images.

3. Double-click the desired image. It will be imported into the project and the options of having it centered and/or full-
scale or scale to fit. Batch import by using Shift+Click to select images. Edit the preferences for each level if
desired.

4. Add any remaining levels as desired. Click OK when finished.

5. Click Save or Save Version to save the changes.
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Organizing Levels via the Sidebar

The Sidebar Tab contains two columns - Unassigned Project Navigator Pancl B %
Levels and Sidebar Levels. The levels are displayed in I icon it [ Cuctioilel| = o
alpha-numerical order when imported. However, usingthe | 7<= el
. Level 0-5 - Level +3
left/right, up/down arrows, levels can be rearranged. Warning - Level 0 Level +2
Warning - Level1 = Level 0
Levels moved to the sidebar can be arranged as necessary | et e
by selecting the level and using the up/down arrows. The Warning - Level 3 Level 2
. ZONE 001
level at the top becomes the Home level and, in the Levels ZONE 002
tab, will be depicted with a house icon. e i
ZONE 003 [LEVEL -1]
ZOMNE 003 [LEVEL -2]
ZONE 004 [LEVEL +1]
ZOMNE 004 [LEVEL 0]
ZOME 004 [LEVEL -1]
ZONE 004 [LEVEL -2]
ZOME 005
ZONE 006 [LEVEL -1]
ZOME 006 TLEVEL -21 ia

Edit Level Properties

To edit the properties of a level, select the desired Level (& edit properties o) |
from the Levels tab in the Project Navigator Panel and click

the Level Properties button. | Level Properties | Background Position |

D evel_+3
Mame Level +3
Description

Background Image Level +3.png

Badkground Color I:‘

& 0K ] l 3 cancel

Remove a Level

To remove a level, select the desired level from the Levels tab in the Project Navigator Panel Levels tab and click
Remove.
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Fire Alarm Devices

Once the configuration data has been imported from LE2, fire alarm devices can be assigned to project levels.
From the Project Navigator Panel, select the Object Model tab. The example below shows a typical
configuration:

Project Mavigator Panel =
| [ Levels | 4/ symbols | [E Object Model | Sidebar |

Select subsystem ’ {y Fire VI

= Object Tree | .7 Equipment List I &) PA Zones |

Q |

Path Value Lov2]
E} € L@ti-View
=} og¢ Fire
25 Activelnstance box(1a
=t .7 Adapters
=t .7 Adapterl
&5 Adapter Status COnline
4 Driver Simulator
":"_.'? status Mermal
-':’—_j' status MNormal
- 4g¢ Panels
=™ Node 01
£5 Description Mew Site
4 FASID Nede 01
—h¢ Loops
= 3¢ Loop 01
4% Enablement Status Mot Applicable
45 FASID Loop 01 o
25 Mame Loopl
E] status Maormal
+- 57 Loop 02

+- 7 Panell0

E—Tjr status Marmal -
4| | »

[Hide placed items][Show all ibems] [Find unmatched placed ibems]

Sub-menus provide the following information:
Displays the fire alarm system based on the imported configuration in a tree format.

Object Tree « Click + to expand each entity, ultimately displaying individual properties.

o Click -to collapse the expansion.
Displays the fire alarm system based on the configuration in a list format.

Equipment List « Click Name to sort entities by name, in alphanumerical order.

« Click Location to sort entities by location, in alphanumerical order.
PA Zone Displays any public address entities forming part of the fire alarm system.

Search for entities in each subsystem using key words using the Find unmatched placed items button.
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Assign Devices to Locations

IMPORTANT! To assign devices to their exact location in the building, it is recommended that blueprints produced

by the fire systems company, detailing the fire system, are used. These drawings will ensure devices are placed in
the correct locations.

File View Tools Help

Y FICER Normal Operation
I
@ e Level +3
T BB R 38 4O P2 ¢ H %A a wme-m | ] = 0 E | Q Q@ # 2 B E| &
Alarm Status
h =
% ahing i) ©
& Fire Iy ~ | Project Navigatar Panel & x
£ Account Management [:] "‘Pl els | < symbols | @ Object Mode! Sidebar
A
e Cntoion sl Select sLbsystem & Fre -
(@ Workstation Config | =y =
pom————— -t ) =objectTree | s Equpment st | a9 paZones |
)
F ) ) Q
& : : path [value [ ocation =]
1 ' '
P | I Online
' ! Taktis
o ' ' Normal
) I Normal
= ' |
'
= : ) AUTO CONFIG. =
] [ !
I 1
) ! m
' !
[} 1
) 1
ide placed items[show al items|
Properties Panl & x
G#Base | o Appearance | i Flags | 1\ toubles
Is.Node 01.Loops.Panel 10, Devices Panell0 Device
- —
7
| ) X7, e
L 1 e <
— < [ i ] v PropertiesPanel | Fiter Items Panel
e}
Editor Mode Zoom: 370% LUnsaved changes

Logged on as: Adrinistrator Workstation ID:box01a Online 23/06/2019 10:25

From the Object Model, Equipment List, and PA Zones tabs, drag and drop fire alarm devices to their
corresponding Level locations. Detailed information about the device is displayed in the Properties Panel.
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Symbols

L@ti-View uses symbols to represent a selection of commonly used fire alarm panels, detectors, and associated
devices. Drag and drop symbols on levels to replicate the fire alarm system. These symbols are automatically

imported with the project configuration.

Other library symbols can be imported within L@ti-View. Symbols can be created and imported from outside of
L@ti-View, provided they meet the criteria outlined later in this section.

To add a Symbol to a Level

1. From the Levels tab, select the level where symbols are to be added.

2. Click the Symbols tab and select the desired symbol.

3. Drag the symbol to the desired location on the level. From there, the properties can be edited, and it can be moved
and resized. Using the Properties panel, symbols can be further configured by the user.

Version 1.00 | May 2020 | MAN-1443HA

Hochiki America Corporation
Page 50

L@ti-View Installation and Configuration Guide



fh HOCHIKI

Creating a New Project

Hotspots

Hotspots are designated locations that link to a specified area when clicked.
Hotspots can be bordered or invisible. The cursor changes to a clickable
hand cursor when hovering over them and a tooltip appears with the linked
location.Hotspots can only be created or edited in Editor mode.

Creating a Hotspot

1. From Editor mode, centralize the desired Hotspot area. Frekeshie | e "
2. Select the Hotspot icon (circled below) and draw the -
outline for the desired hotspot, clicking at each corner, A TR Ij# :
joining the first and last points. The completed hotspot T e
will be filled in, as selected in the Hotspot menu bar. The .
shape fill does not display in Control mode, and the B
outline can be turned off using Stroke Style. & i
L g
NOTE The scroll bar can be used during hotspot creation :’: _,
when desired plot points are off-screen. To cancel an =
incomplete hotspot, press Esc. To delete a hotspot, select i
it and press Delete. L
[l
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3. When the hotspot is complete, click the Selecticon and
select the hotspot.

4. Select the Base tab of the Properties tab. Select the
desired Target.

5. Click Save or Save Version.
6. Test the Hotspot in Control mode.

Hochiki America Corporation
L@ti-View Installation and Configuration Guide

Properties Panel B X

s Base * . Appearance | ﬁ Flags | ', troubles

JPC Path

Name Flotted Hotspat 7

Description

Location

Contains Path

Target zone_001 =
site_plan -

warning_-_level_-1
warning_-_level_0
warning_-_level_1

warning_-_level_2

||_Properties Pane warning_- level_3

zone_002
zone_003_[level_+1]
zone_003_Jlevel_-1]

Version 1.00 |
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Shapes and Lines

Shapes and lines can be added to the current level, and various attributes (colors, fill, borders) can be changed,
depending on the shape.

Grouping and Transforming Shape Tools

Two shapes can be grouped or changed using these tools.
iy o

Minus Back Subtracts the objects in back from the front-most object.
Minus Front The front-most objects will be cut out from the back-most object.
Removes the part of a filled object that is hidden. Removes any strokes and merges any adjoining or
Merge . . i .
overlapping objects filled with the same color.
Intersection Traces the outline of the region overlapped by all the objects.
BASIC SHAPES MINUS FRONT MINUS BACK MERGE INTERSECTION
Zones

Zones are irregular polygons drawn to surround specific areas or levels, and they can be color coordinated and
allocated to one of the following types:

o Detection Zones
« Evacuation Zones
« Operational Zones
o PAZones

Zones can overlap, be duplicated on spilit levels, and can be filtered by type.
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1. Click the Grid icon, which turns on the 10x10 grid overlay. Project Navigator Panel & X
2. Select the desired level for the zone. | [lievels | < symbols | [ ObjectModel | — sidebar |

3. Click the Zone icon and select a zone type from the zone
drop-down menu.

Select subsystem ’ %y Fire - ]

;: Object Tree | -7 Equipment List | & PA Zones |

4. Draw the desired shape for the zone, ensuring that the first a |
point and last point connect. This is confirmed when the —
shape's shading turmns solid. i ~ [valse | Locstion

—t o Zones
- ;¢ Detection Zones
NOTE Hold down Shift while drawing to create lines in 45° T .
angles. 25 Enablegfie... Enabled
£ FASIQ DetZoneN001
L5 Margk Detection Zonel
25 Pagnt Evacuation Zon...
5. When the zone is complete, click the Select icon and select ills Zfne :tatus trJ\J |
2% JoneStat.. Nu
the zone. Efstatus Mormal

6. Select the Base tab of the Properties tab. J H-i PFEtZone0002 |Zm2;lj

7. Select the Object Model tab of the Project Navigator 7 i
Pane| Wlth the subsystem Fire ’Hide placed items”Shi all items] [Find unmatched placed items]

i) . ’
8. Select the zone to allocate and drag it to the Properties panel ¢« po / ey

of the newly-created zone to auto-fill the relevant fields.

i Base | glAppearance | gf Flags | *, Troubles |
9. Click Save or Save Version.

IPC Path L @ti-View,Fire.Zones.Detection Zones.DetZone0001
] . Mame Detection Zone 1
NOTE Two or more zones given the same Object Model i
details will be treated as the same zone for alert purposes. ,
Location Zone 1
Contains Path

Properties Panel Filter Items Panel
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Text

Text can be added and edited like other objects in L@ti-View.

1. Toaddtext, click the Text icon and set the font attributes and the desired background.
2. Click the location on the screen and enter the desired text. Text boxes can be relocated using the Select icon.

NOTE Text can be edited in the Appearance tab of the Properties Panel. Press Enter to apply the changes. Use the
box handles to resize the box to fit the new text if required.

3. Click Save or Save Version.
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Flags

Zones and Symbols can display an alert flag generated by one or more external sources. The displayed flag is
always the highest priority alert if several input sources send alerts.

Alert flags are allocated a higher z-index than symbols and zones and always appear on top of the display. Alert
flags can also be given a positional offset from their nominal position (center point) so that conflicts between
adjacent symbols can be easily resolved. Alert flags pulse on priority-state transitions, the duration of which is

configurable.

A project’s flags, properties, and settings can be customized in the Edit Project Setting screen of the 2D GUI
Editor. The default alert flags are:

/0\ Unknown »6 Information
| | | |
- b — 4

s

) Warning -, Reduced Service

Alarm Priority Alarm

4

gi Critical 3 Alarm (Pre-Fire) Fl Critical 2 Alarm (Fire)
o Critical 1 Alarm ﬁ

Auxiliary Alarm 2 Implicit (Disablement)
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Navigation Buttons

Navigation buttons can be added that allow L@ti-View to link to other levels within a project. The navigation
buttons can be assigned the following properties:

« Main button text (mandatory)
« Description text (optional)

« Target page (mandatory)

« Font name (mandatory)

« Font base size (mandatory)
« Icon (optional)

« Accessory icon (optional)

MAIN BUTTON TEXT

ICON ‘ ACCESSORY ICON
g i }
- Parking
DESCRIPTION
Font M5 Shell Dlg 2 - Size: Pt |5 E Icon Mo Icon - Accessory Icon | 2 right arrow_alpha.png b4
e - ] lock.png o
— o a () accept.png (| =4 lorry.png
- 1 arrow_down.png B map.png
: Butto[ ] 5 & arrow_redo.png 7| map_go.png
A “Z, arrow_refresh.png H 5 photo.png
| } | ——? arrow_right.png :i | picture.png
Lad qs‘ arrow_rotate.. lockwise.png "L & pictures.png (W
‘@ arrow_rotate_dockwise.png . 1= report.png [
58 arrow_switch.png right_arrow_alpha.png
) :]_] arrow_turn_left.png b | script,ong i

1. Click the Button icon and select the desired location for the button.

2. Click the Select icon and click the button to edit. Drag it to a new location, resize the button, or change any desired
attributes.

3. Enterthe button properties in the Base tab of the Properties panel. Select a Target for the button, and, optionally,
enter a description which will appear as the subtitle on the button. Press Enter to apply the changes.

4. Inthe Appearance tab, enter the button's main description in Text field and press Enter to apply the changes.

NOTE Buttons must always be in the front of all other objects to be functional.

5. Click Save or Save Version.
6. Test the Button in Control mode.
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Macro Buttons

Adding Macro buttons is the same procedure as adding Navigation buttons, however a Function is selected
rather than a Target, and there are no icons or subtitles.

The following Macro functions are available:

Show Schematic
Fire: Create maintenance log
Fire: Close Contact
Fire: Enable Device
Fire: Disable Device
Fire: Disable Zone
Fire: Enable Zone

Fire: Evacuate Zone

Hochiki America Corporation

Fire: Open Contact
Fire: Reset Panel
Fire: Silence Buzzer
Fire: Silence Panel
Fire: Show In Status Tree
Fire: Show In Maintenance Page
Fire: Show Operational Procedures

Fire: Start Zone Test

L@ti-View Installation and Configuration Guide

Fire: Start Find Mode

Fire: Start Poll

Fire: Simulate Fire

Fire: Stop Find Mode

Fire: Stop Poll

Fire: Stop Zone Test

Workstation: Suppress Audible Alerts
CCTV/PIS: (TBC)

Version 1.00 |

May 2020 |

MAN-1443HA
Page 58



Saving, Exporting, and Restoring

Projects fh HOCHIKI

SAVING, EXPORTING, AND RESTORING PROJECTS
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Saving a Project

Projects should be saved regularly. To save the entire project with the same project name,

1. Click Save Project.
2. Enterany desired details (optional).

@ Save Project @l&]

Please enter details of the changes.

[ o OK H 3 cancel ]

3. Click OK.

NOTE The Change Log can be viewed using Edit Project Settings.
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Saving a Project Version

Saving time-stamped project versions allows the user to reopen and save an earlier version. It is recommended
to save the current project as a project version before making any changes to it. To save a version,

1. Click Save Project Version.
2. Enter any desired details (optional).

i R
@ Save Project Version [i‘éj

Please enter details of the chanaes.

[ « OK ” 3£ Cancel l

3. Click OK. The project version is time-stamped and saved to the project folder under Versions.

NOTE To view previous saved project versions, click Restore Project Version.
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Exporting a Project

To export a project to a new location, e.g. to a server, FTP site, or to cloud storage,

1. Load the project or version to export.

2. Click Export Project.
3. Select the desired destination click Select Folder.The project will been saved (with the same file name) to the des-

tination folder.
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Restoring a Project Version

L@ti-View starts up using the last saved configuration. If the screen canvas is blank, or if there is an error or
omission, either restoring a project version or load an existing project. To restore a project version,

1. From Editor mode, click Restore project version.
2. Navigate to the desired saved project and click Select Folder.
3. Click Yes to replace the current version. This will load a working copy of the project.

NOTE Restored versions should be thoroughly reviewed before saving.
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SYSTEM CONFIGURATION MENU

The left side of the L@ti-View screen contains a user-dependent configuration menu. The following shows the

buttons allowed for a full access user.

& 20 GLI
~ Alarm Config
Alarm Status
Archiving
s Fire

E. Account Management
#y Fire Configuration

& Workstation Config

Hochiki America Corporation
L@ti-View Installation and Configuration Guide
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2D GUI

Refer to 2D GUI Editor Mode for complete information about this option.
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Alarm Config

Alarm Config opens the alarm configuration table, where the alarms can be created, copied, deleted, and
filtered.

File View Tools Help
& B o o Normal Operation

@ oau Alarm Configuration

|| Alarm Configuration Table

/2 Alam Config
Alarm Configuration Table

Alarm Status

IPC Path Description Suggested Action Script ID Acknowledge Rec Pricrity

Logged on as: Administrator Workstation ID: box01a Orline 5/21/2020 3:12:00 PM
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Alarm Status

The Alarm Status tab provides access to the following views:

o Alarm List

« Alarm Event History

« System Event Log

« Additional Alarm Information
« Suppressed Alarms Table

Alarm List

The Alarm List is the default view when selecting the Alarm Status tab. This view displays filtered results using
buttons, drop-down menus, and column headers.

Ele View Tools Help

& @& @ Normal Cperation
System Alarm Status

@ Do W

(&) Mlarm EventHistory () System Eventlog (@) Additional Alarm Information [ Suppressed Alarms Table
#  plarm Config
Alarm List
st Alarm Actons Pricrty Fiter Subsystem Fiter
4 Achiving Admowiedge | (Unacknonledge | Clear AL ~] [
e Fire
L) Leti-View
£ Account Management PAVA

& Fire Configuration

Subsystem Equipment  Alert
(# Workstation Config

5/21/2020 3:25:16 PM Fire Adapter 1 Trouble
5/21/2020 3:25:16 PM Fire Node 01 Trouble

Fiter Counn: Bt patters 1] Case sersitve

[atarm View Summary: Total: 7, Unacknowledged: 7 ‘

Logged on as: Administrator Wrkstation ID: box01a Online §/21/2020 409:00 Pl

Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
L@ti-View Installation and Configuration Guide Page 67



System Configuration Menu ‘.O HOCKHIKI

Alarm Event History

This button opens a page that organizes and filters the Alarm Event History using column sorting, drop-down
menus, and various filters.

File View Tools Help

@& BHa Normal Operation
@ o System Alarm Status
- (& AlarmList () SystemEventlog (@ Additional Alarm Information || Suppressed Alarms Table
% pam Config
Alarm Event History
FEmeRT Time Fiter ubsystem Fiter
Z Archiving ® Lasthour T
. Fire
& = ) Last 24hours A
Snccomtorogement| | O Betnesn 221/2020 s 512202 A
# Fire Configuration Time Alarm 1d Event By Subsystem Equipment Alert il
@ Workstation Config || |5/21/2020 3:25:16 PM 30 CREATE  SYSTEM Fire Adapterl Fire
5/21/2020 3:25:16 PM 29 CREATE SYSTEM Fire Adapter 1 Disablement E
5/21/2020 3:2516 PM 28 CREATE  SYSTEM Fire Adapter1 Supervisory |
5/21/2020 3:25:16 PM 27 CREATE SYSTEM Fire Adapter 1 Carbon Monoxide
5/21/2020 3:2516 PM 26 CREATE  SYSTEM Fire Node 01 Info
5/21/2020 3:2516 PM 25 CREATE  SYSTEM Fire Adapterl Trouble
5/21/2020 3:25:16 PM 24 CREATE SYSTEM Fire Node 01 Trouble
5/21/2020 3:2546 PM 1 CLEAR  SYSTEM Fire Node 01 Tnfo
5/21/2020 3:25:16 PM 17 CLEAR SYSTEM Fire Node 01 Trouble
5/21/2020 3:2516 PM 21 CLEAR  SYSTEM Fire Adapter1 Supervisory
5/21/2020 3:25:16 PM 23 CLEAR SYSTEM Fire Adapter 1 Fire
5/21/2020 3:2516 PM 18 CLEAR  SYSTEM Fire Adapterl Trouble
5/21/2020 3:25:16 PM 20 CLEAR SYSTEM Fire Adapter 1 Carbon Monoxide il
Filter Column: ~ | Eilter pattern: Case sensitive |Fixed string v
ter Col Al i a d
Alarm List
Alarm Actions Priority Filter Subsystem Filter
Acknowledge | L Clear [>= =] < [aL
Fire
L@ti-View
[
Subsystem Equipment  Alert Description AckTime  Ackd By
Adapter 1 Trouble
Node 01 Trouble
Fiter Column: Eiter pattern: 7] Case sensitive
[Atarm View Summary: Total: 7, Unadknowledged: 7 ‘

Logged on as: Administrator Warkstation ID: box01a Oriine 5/21/2020 3:29:00 PM
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System Event Log

This organizes and filters the System Event Log using column sorting, drop-down menus, and various filters.

File View Tools Help
@& FH Mormal Operation

@ 2D GUI System Alarm Status

[ — (&) MarmUist () Alarm EventHistory [ () System EventLog | @ Additional Alarm Information || Suppressed Alarms Table:
é larm Config

System Event Log
Alarm Status

Time Filter
& Archiving Lasthour
& Fre O Last 24hours
@ hccontorogenent| || © Seinesn 221202 snd 51232020
& FreConfiguration " Time Type Text Data B
@ Workstaton Config | | |3 5/20/2020 3:7:40 PM information  Login Successfullogi
37 5/20/2020 3:17:30 PI mation Ceonfig file error  Config::loadCo. E
3 5/20/2020 3:17:30 Ps No XML found 1
35 5/19/2020 7:41:21 AM EVENT Clear Alarm No target set fo. L
34 5/18/2020 9:28:53 PM information  Logout Successfullogo.
33 5/18/2020 9:28:47 PM EVENT Commit Alarm No target set fo.
2 5/4/2020 347:25 AM Information  Raised EventID: 20 P...
31 5/4/2020 347:25 AM Information  Reised EventID: 0. Pa
30 5/18/2020 1:55:53 PM information Login Successful logi.
2 5/18/2020 1:55:46 PM information  Login Faledlogi for
28 5/18/2020 1:55:35 PM information Ceonfig file error  Config::loadCo.
b 5/18/20201:55:35 PM serious No XML found
26 5/5/2020 10:53:33 AM information Logout Successful logo. il
Fiter ot (A=) Eer patern: S P—
Alarm List
Alarm Actions Priority Filter ubsystem Filter
= = ] o)A = [
Fire
L®ti-View
PAVA

Subsystem Equipment Alert Description Ack Time Ack'd By

5/21/2020 3:25:16 PM Fire Adapter 1 Trouble
5/21/2020 3:25:16 PM Fire Node 01 Trouble

Fiter Gobarr: e pattem: ] Came serive

|Alarm View Summary: Total: 7, Unacknowledged: 7 ‘

Logged on as: Administrator Workstation ID: box01a Orline 5/21/2020 3:31:00 PM
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Additional Alarm Information

The Additional Alarm Information tab organizes and filters additional alarm information using column sorting,
drop-down menus, and various filters.

i
@& BHa Normal Operation

@ o System Alarm Status
2 (J MlarmList () Alarm EventHistory  (J SystemEventlog | () Additional Alarm Information | || Suppressed Alarms Table
% Aamconfig
Additional Alarm Information
- Aam Status
5 ahiving
& Fire
B Account Management

& Fire Configuration

@ workstation Config

Priority Fiter Subsystem Filter
= -] Jaw

Fire
L@ti-View
PAVA

Equipment Alert

5/21/2020 3:25:16 PM Fire
5/21/2020 3:25:16 PM Fire

Fiter Column: Eiter pattern:

Alarm View Summary: Total: 7, Unacknowledged: 7

[7] Case sensitive [Fixed string -

Logged on as: Administrator Warkstation ID: box01a Orline 5/21/2020 3:33:00 PM
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Suppressed Alarms Table

The Suppressed Alarms Table tab organizes and filters the suppressed alarms table information (if any) using

column sorting, drop-down menus, and various filters.

Fle View Tools Help

& B Normal Operation
) = System Alarm Status
2 () MlarmList () Aarm EventHistory (0 SystemEventLog @ Additional Alarm Information | || Suppressed Alarms Table
% Aamconfig
Suppressed Alarms Table
sl IPC Path Description User Name Reason Priority Expiry Time Manually Suppres
5 Ahing
& Fire
sccount Management
& Fire Configuration
& Workstaton Config
Alarm Lt
Aarm Actions Priorty Fier ubsystem Fiter
[ [Ccear ] [=xJar =) [a
Fire
L@ti-View
PAVA

Equipment  Alert

Description AdcTime

5/21/2020 3:25:16 PM Fire Disablement

5/21/2020 3:25:16 PM Fire
5/21/2020 3:25:16 PM Fire

Filter Column: ilter patter:

Alarm View Summary: Total: 7, Unacknowledged: 7

Hochiki America Corporation
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Archiving

The Archiving tab allows the user to view, create, copy, and delete a Database Archiver Configuration. L@ti-
View will automatically convert any frequency over 24 hours to days and hours.

File Yiew Tools Help

& @@ Nermal Operation
) oo Database Archiver Configuration
e | Datcbase Archiver Configuration
Database Archiver Configuraton Table
Aarm Status
Name Frequency  Youngest Record Source Table Time Column ~ Archive To Delete Archived
L — ) L@ti-View_backups_eventlog 24h0m0s OLe6hOm0s eventiog time C/Users/egers/ L @ti-View /i g archive, delete
& Fre L@ti-View_backups alarmiog  24h0m0s 91d6hImds alarmlog createtime C:/Users/cgera/documents/L@ti-View archive/alarmlog  archive, delete and vacuum
BoAccount Management| | | L@t-View_backups_alarmeventiog 24f0m0s 91d:6h0m:0s alameventiog  time CefUsers/egera/documents/L@ti-View_archive/alammeventiog archive, delete and vacuum
# FreConfiguration
@ Workstation Config
( view I New. I Copy. I Delete. I Refiesh ]

Logged on as: Administrator Warkstation ID: box01a Online 5/21/2020 3:34:00 PM
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Fire

The Fire tab provides access to the following:

« Fire System
« Maintenance
« Event History
o FAS Topology
o Alarm List

o Status Tree

NOTE The Fire tab defaults to the Alarm List upon opening and synchronizes every 10 seconds.

Fire System

On the Fire System page, report styles can be selected, acknowledged, and printed. There is also a visual

representation of the selected zone, with options to move or resize, and the ability to move up, down, left or right
to see different evacuation zones.

Ele Yiew Tools Help

& Fom Normal Operation

~=er ) FIRE GUI
# Maintenance [ EventHistory 4 FASTopology () AlarmList = Status Tree

/2  Aarm Config ©

Alarm Status § Fire Activations|

5 v
= < & Actve Fire Alzrms

& Fre

Actioned Inv Time Time. Device EVZone
£iAccount Management 2 000000 5/21/202010:19:17 AM Carbon Monoxide
# FreConfiguration K 00:00:00  5/21/2020 10:19:05 AM Fire

Type

@ Workstation Config

[J Admwwledgﬁ] [ﬁ Slence Navms] [e) Reset Pane\l [ Manual Evac]

‘Alarml/lewsummary:mta\Zunacknnw\edged7 Fire | 1 | Trouble | 2 | Dissblement | 1 | Test | 0

Logged on as: Administrator Warkstation ID: box01a Orline 5/21/2020 3:59:00 PM

Maintenance

The Maintenance tab displays all of the nodes in the configuration. Selecting a node from the list will populate the
Equipment list on the bottom of the screen. Upon selecting a device, the following options are available:

« Enable selected device
« Disable selected device
« Start polling a selected device
Stop polling a selected device
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« Operate selected equipment
« Restore selected equipment

Selecting at least one item from the Equipment list enables the Enable / Disable buttons or allows the user to

manually create a Maintenance Log entry.

When selecting any of the above options, a window will appear requesting a reason why the action has been

done. At least one character must be entered to proceed.

File View Tools Help

NER Norml Operatin
@ =T FIRE GUI
o — Deenirsiay  rasToooy @ Aomist st Tee
2 Alarm Config
S Aemstans (- System Information] (1 Active Events| [ /” Maintenance Log
5 Archiving Select Equipment Type: Informaton
& Fire [ R
BiAccountManagement ] selectpancs WEE | [N Value
& Fre Configuration E Enabled
1 FASID Pancll0
ot FASID | Name [type  |Description | Name Panel 1O
Status Normal
P— DG E -
Q QuikFiter:  Laop + [ Advancedriter] | Cieae
FASID Name Type Description  Parentltem  Panel Loop Enablement Stat
Loop 0L Loopl Loop [No Data] FireNET L@titude 0 Not Applicable
Loop 02 Loop2 Loop No Data] ireNET L@titude 0 Not Applicable
nel B a

eNET L@titude 0

Enabled

9 Refresh | [ i Create Log Entry

|A\am\ View Summary: Totai: 7, Unacknowledged: 7

Fre | 1 | Trouble | 2 | Disablement | 1 | Test| o ‘

Maintenance Log
To create a manual maintenance log entry,

1. From the Fire tab, select Maintenance > Maintenance Log.

2. Click New at the bottom (or right-click and select New...). The
Creator window will appear.

3. Add/ edit the log entry. The time and date defaults to the local
system time, but this can be changed. Check the box to Keep
the dialog open to create additional entries if desired.

4. Click Create when finished.

NOTE Asset Codes cannot be added when creating an entry,
but can be edited later by double-clicking the desired entry and
making any needed changes.

Logged on as: Administrator Workstation ID: box0la Orline 5/21/2020 %01:00 PM

Hochiki America Corporation
L@ti-View Installation and Configuration Guide

= Creator u_“ e S|
Time 01/01/2020 [+ [ie] m 12 : 00
=
Short Description
Detail
Asset Codes
External Ref
User
7] Keep dizlog open Create ] [ Cancel
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To export a maintenance log file to a .csv file (which can be opened in Microsoft Excel or Google Sheets),

1. From the Fire tab, select Maintenance > Maintenance Log.
2. Click Export at the bottom (or right-click and select Export...).
3. Enterafile name and select a location.

4. Click Save.

To create a maintenance log report,

1. From the Fire tab, select Maintenance > Maintenance Log.
2. Click Report at the bottom.

) Print Preview [

Report Print Preview

Time 25/05/2020 17:14

Author Administrator

Title FAS Active Events

Description

Tide: FAS Active Events

e —————— + Q@@

Ee@E=e==laaa

3. Enter the report details and use the icons to change the layout as desired.
4. Click Generate Report.

Active Events

From the Fire tab, select Maintenance > Active Events. Active events can be filtered by specific event type,
Quick Filter, or Advanced Filter.

Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
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Ele View Tools Help
& F o

Normal Operation

@ werkstation Config

& Frespsen oty 4 ASToobgy (9 Asmist = stsusTies

[ speninomaten) ([CAASiEEER) (o Honterenceiog)

Active Panel Events

FIRE GUT

Select event type: (Al -)[Q

~ [ AdvancedFilter| [ Clear

5/25/2020 12:11:20 PM Infor = Fire

5/25/2020 12:09:07 PM Super ed Fire. SYSTEM EVENT
5/25/2020 12:08:50 PM Carbor ed Fire. SYSTEM EVENT
5/25/2020 12:08:45 PM Fire ed Firg SYSTEM EVENT
5/21/202010:19:30 A... Trouble  Raised FireNET L@titude SYSTEM EVENT
5/21/202010:19:29 A.. Disable... Raised FirePanels.PanellO SYSTEM EVENT
5/21/2020 10:19:29 A. Informa... Raised FireNET L@titude SYSTEM EVENT

Value
User LoggedIn
7205750408910,

‘A\srm View Summary: Total: 6, Unacknowledged: 6

Fre | 1 | Trouble | 1 | Dissblement | 1 | Test | 0

Event History

Logged on as: Administrator Workstation ID: box01a Oniine 5/25/2020 5:13:00 PM

The Event History page shows all historic events with additional information (if available). The history can also be
used to create reports or exported as a .csv file.

The Event History can be very long and detailed, so authorized users can view and/or rearrange it by:

« quick filter (e.g., Loop)

« clicking column headings

« changing time/date periods

« choosing event type and sub-type

« using an Advanced Filter tool (i.e., drop-down menus for Columns + Operands + Data)

Hochiki America Corporation
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Mormal Operation

File View Tools Help
& @&
@ »w

% Alarm Config
Alarm Status
5 Ahiving
& Fre
£ Account Management.
# Fire Configuration

@ Workstation Config

FIRE GUI
@ Fresysen/° wantenance G A Topdogy (D Mlrmust [ Staws Tree
Filter Event data: Filter time period
Select event type: Al v] O Lasthour
Sub type: [ - Last 24 Hours

Quick Filter: Loop = - Qear (@ Between FriFeb 21 2020 and Thu May 212020

Historic events Information

EventID Type Sub Type Time Panel Device Zone Actioned By Reason Fire Adapter Vendor Info Value

25 Carbon ... Raised 5/21/2020 10:19:17 AM Fire.Panels.Panell0 SYSTEM EVENT Fire Adapters. Adapter 1 Card o

21 Disable... Raised 5/21/2020 10:19:29 AM Fire.Panels.Panell0 SYSTEM EVENT Fire Adapters.Adapter 1 Description Ne Event

05 AM Fire.Panels.Panell0 Fire Adapters. Adapter 1 TInput 8

18 Informa... Raised 5/4/2020 7:45:14 AM  FireNET L@titude SVSTEM EVENT Fire.Adapters. Adapter 1 Local-id 57674222738079.

17 Informa... Cleared 5/4/2020 7:4514 AM  FireNET L@titude SYSTEM EVENT Fire Adapters. Adapter 1 Panel 1

18 Informa... Cleared 5/4/2020 7:47:24 AM  FireNET L@titude SYSTEM EVENT Fire.Adapters.Adapter 1

20 Informa... Raised 5/4/2020 7:47:25 AM  FireNET L@titude SYSTEM EVENT Fire Adapters.Adapter 1

0 Informa... Raised 5/4/2020 7:47:25 AM  FireNET L@titude SYSTEM EVENT Fire.Adapters.Adapter 1

17 Informa... Raised 5/4/20207:47:25 AM  FireNET L@titude SYSTEM EVENT Fire Adapters.Adapter 1

19 Informa... Raised 5/4/2020 7:47:25 AM  FireNET L@titude SYSTEM EVENT Fire.Adapters.Adapter 1

32 Informa... Raised 5/21/2020 10:20:06 AM FireNET L@titude SYSTEM EVENT Fire Adapters.Adapter 1

23 Informa... Raised 5/21/2020 10:20:25 AM FireNET L@titude SYSTEM EVENT Fire Adapters.Adapter 1

32 Informa... Cleared 5/21/2020 10:22:11 AM FireNET L@titude SVSTEM EVENT Fire.Adapters. Adapter 1

33 Informa... Raised 5/21/2020 10:22:12 AM FireNET L@titude SYSTEM EVENT Fire Adapters.Adapter 1

34 Informa... Raised 5/21/2020 10:25:13 AM FireNET L@titude SYSTEM EVENT Fire.Adapters. Adapter 1

34 Informa... Cleared 5/21/2020 10:25:13 AM FireNET L@titude SYSTEM EVENT Fire Adapters.Adapter 1

35 Informa... Raised 5/21/2020 10:25:16 AM FireNET L@titude SYSTEM EVENT Fire.Adapters.Adapter 1

35 Informa... Cleared 5/21/2020 10:25:16 AM FireNET L@titude SYSTEM EVENT Fire Adapters.Adapter 1

26 Supervis... Raised 5/21/2020 10:13:08 AM Fire.Panels.Panell0 SYSTEM EVENT Fire Adapters. Adapter 1

22 Trouble Raised 5/21/2020 10:19:06 AM Fire.Panels.Panell0 SVSTEM EVENT Fire.Adapters. Adapter 1

21 Trouble  Raised 5/21/2020 10:19:30 AM FireNET L@titude SYSTEM EVENT Fire Adapters.Adapter 1

(Alarm View Summary: Total: 7, Unacknonledged: 7

Fire | 1 | Trouble | 2 | Disablement | 1 |Test| 0

Logged on as: Administrator Workstation ID: box01a Orline 5/21/2020 4:04:00 PM

L@ti-View reports allow both simple and advanced searches to narrow down a specific data type or series.
Advanced filtering can use column headings with boolean expressions plus free-text data:

o =equalto
« !=notequal to
« > greaterthan

« >= greater than or equal to

e <lessthan
« <=less than orequal to

« Lik

e...

Only one filter term can be used.

EXAMPLE

Fire Alarm System (FAS) Topology

[Zone = 2] would show only events that are listed for Zone 2, whereas [Zone != 2] would show all
events except those in Zone 2.

The FAS Topology page lists all connected devices and shows their current Status and Operational Status. The

classes can be expanded or condensed by clicking the + or - icons.

Hochiki America Corporation
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File View Tools Help

@ EoH Mormal Operation
FIRE GUI

@ o

@ Fresystem /" Maintenance (] EventHistory [ . FAS Topology | (&) AlarmList = Status Tree
P Alarm config =

Fire System Tapalogy
-~ AamStatus

8 scivang Name | Dscription Status [ Enablement stetus

5 @ Fire Alarm System
3 Fre 7% Devices

& Norml Ensbled
Account Menagement i i
& FreConfiguration

@ Workstation Config

|Alarm View Summary: Total: 7, Unacknowledged: 7

Fire | 1 | Trouble | 2 | Dissblement | 1 |Test| 0

Logged on as: Administrator Warkstation ID: box01a Orline 5/21/2020 4:06:00 PM

Alarm List

The Alarm List page opens a list of all the alarm events, with an itemized summary of alarm types at the bottom of
the screen.

& @& Norml Operation

@ — FIRE GUI

5 Ao Conti @ Fire System  ° Maintenance (] EventHistory < FAS Topology = Status Tree

larm Config
ar

- Aamstats Priority Fiter

B Archiving Admowledge ] Unacknowledge [ Clear [z= A -
& Fre riority L Description Adk Time Ack'd By
sccount Management

& Fire Configuration

5/21/2020 3:25:16 PM Adapter 1
@ Workstaton Config

5/21/2020 3:25:16 PM Adapter 1
5/21/2020 3:25:16 PM_Node 01

|Alarm View Summary: Total: 7, Unacknowledged: 7

Fire | 1 | Trouble | 2 | Dissblement | 1 |Test| 0

Logged on as: Administrator. Workstation ID: box01a Online 5/21/2020 4:07:00PM

Status Tree

The Status Tree page opens an expandable tree layout of the network and attached devices. Use it to see the
current status and alert types of any listed item.

NOTE The values are controlled by the item type; some will return three values while others will return seven.

Hochiki America Corporation

Version 1.00 | May 2020 | MAN-1443HA
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System Configuration Menu

Eie View Tools Help

Y

Mormal Operation

@ >an
#  Aam Config
Alarm Status
5 Ahiving
& Fre
£ Account Management.

# Fire Configuration

@ Workstation Config

FIRE GUI
¢ Fresystem /" Maintenance [ EventHistory <+ FASTopology (&) Alarm List
Status Tree
Path Value [ Lost Update [ Location
5 @ Let-View

Activelnstance
Adapters
Adapter1

Adapter Status
Driver

alerts

E] Awsiliary

© Carbon Monexide
E] Cause and Effect
& Comms Trouble
E{ Config Mismatch
© Disablement

@ Fire

&] Implicit Disablement
E{ Info

E{ Offline

] Pre-Alarm

& security

@ Supervisory

=@ alets
E] Comms Trouble
& status
Panels
=i & Node01
Description
FASID

Name
o alers
@ status
£ status
= 4% Zones
] status

© status

Carbon Monoxide
boxdla

Carbon Menoxide
Carbon Monoxide
Online

Taktis

Normal

Carbon Monoxide
Normal

Normal

Normal
Disablerment

Normal
Supervisory
Normal

Trouble

Carbon Menoxide

Normal
Normal
Trouble
Trouble
New Site
Node 01

FireNET L@titude

Trouble
Normal

Normal
Carbon Monoside

1612:25
25

16:12:25

1612:25
16:12:25
16:12:25
1612:25

16:12:25

16:12:25

(Alarm View Summary: Total: 7, Unacknonledged: 7

Fire

1

Trouble | 2 | Disablement | 1 | Test

0

Hochiki America Corporation
L@ti-View Installation and Configuration Guide
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Account Management

The Account Management tab allows the management of all user accounts, permissions, and passwords.

Frames and columns are resizable to enable easier reading of long descriptions. For more information on
managing user accounts, refer to Accounts and Access.

File View Tools Help

@& FH Normal Operation
@ = Account Management
e 285 Manage Groups
Aarm Status [a Name  Admiristrator
5 arhvig = Description Full Name
£ Account Management Desaipton
& FireConfiquration Passward
(@ workstation Config Enabled
[a | 7 show assigned tems only
Name

= Grou

((3Jimport | [ &E]export | [ ZRefresh | [ @ya0d | [ ) clone | [ @pekete ) Accept | | (D) Canesl
\
Logged on as: Administrator, Workstaton ID: box01a Online 5/21/2020 4:19:00 PM
Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
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Fire Configuration

The Fire Configuration tab has two tabs - Panel Comms and Fire Configuration.

Panel Comms

The Panel Comms page controls the panel, panel communication type (IP or Serial port), and it allows a
communication test.

File | View Tools Help
b B & &8 Normal Operation
& mau Fire Configuration Page
Alarm Config
' Panel Comms .
ol & Set-up Connection to a Fire Panel
2 g [ Fire Configuration C :
™ fre onnect to panel

£ Account Management Panel Typs- Hochiki Latitude (UL) @

¥ Fire Configuration

&) Workstation Config IP Address: 192.168.147.121

Panel connectivity test

8 [ 0x00 ] I Connectivity established. ]

Fire Configuration

The Fire Configuration page allows a user to import a configuration file from LE2.

File View Tools Help

A ] Mormal Operation
® waux Fire Configuration Page
#  AarmConfig
Samat PR D Import Loop Explorer Configuration from a connected panel or file
[ Fire Configuration
Loop Explorer
S——
@ Workstation Config
Logged on as: Administrator Workstation ID: boxDia Online 5/22/2020 11:33:00 AM
Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
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Workstation Config

The Workstation Config tab allows authorized users to access many configuration options, as shown in the left-
hand menu below.

WARNING! Workstation configuration changes can have serious consequences that could affect the L@ti-View
system’s functionality or security.

To allow configuration recovery, export the current configuration or the entire project before making any
configuration changes.

WARNING! Due to the potentially adverse consequences of experimenting with live systems, it is recommended
that Demonstration mode be enabled for training or project creation scenarios.

Always import or reload the Operational configuration or project when finished.

WARNING! Workstation configuration changes can be made in Control Mode or Editing Mode, so Operational
configuration changes should be restricted to specifically authorized persons only.

NOTE Configurations and projects are not the same thing. A typical configuration file export is about 12 Kb, while an
exported project folder holds many files.

Training and development projects can be exported, and then imported if they require further work. Although it is
not recommended, configuration files can be directly edited at the source using an appropriate text-only editing
tool.

General

Use this tab to add a site name to the project.

File View Tools Help

b Bo e Normal Operation
@ »an Workstation Configuration
7 plarm Config
£ Gener )
RS £ £l {;: General options for L@ti-View
H Ardiving & Printing -
General
PO
% Sound "
§ TR DS % Site Name: | L@t View) |
& FreConfquatan = Monkors
@ workstation Config 2 Aarms
@ Language
B Event Log
 License
Logged on as: Administrator Workstation ID: box01a Cnline 5/22/2020 11:42:00 AM
J
Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
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Pﬁnﬁng

Use this page to change or confirm the L@ti-View default print settings. The printer drop-down menu shows the
printers already installed on the workstation.

NOTE Choose Print a screenshot to automatically print screenshots of specified alarms for emergency
responders, or Save a screenshot PDF to save a PDF of the screens.

File View Tools Help

@ EH Mormal Operation
@ > Workstation Configuration
P Alarm config
SRl % General & Options for printing from L@ti-View r
g
- - Choose Automatic Screenshot Action
£Account Management ~Jem &, When a specified alarm oceurs, the system will automatically:
- At Sl Sl Print a screenshot using: [ Adobe PDF -l
— LS Save a screenshot POF in [ C:\Windows ]
Oz Print Screen delay (secs) requires restart
5 Event Log
Select Which Alarms Trigger Automatic Screenshot Action
« License
Lowest Priority | Normal ] T [MoAction -]
[mfo ] [ ] [NnAcUonj
[ Trouble ] 3 [NoAction -]
[(oine ] ) o Action -] =
[ Comms Trouble ] ) [NoAction -]
[ Config Mismatch ] ) o Action -]
[ Cause and Effect | S (Mo Action -]
= ) - )
[ security | S (Mo Action |
[Test | . [noAction -]
[ mplicit Disablement | S (Mo Action |
[ Disablement | . [noAction -]
[Auxmsry ] [ ] [NnAcUonj
[ Pre-Atarm | @ (Mo Action | 4
[Flve ] [ ] [NnAcUonj
T e | PN [N (. | 2
_____________________________________________________________________________________________________________________________________|

Logged on as: Administrator Workstation ID: box01a Orline 5/22/2020 2:27:00 PM

Sound

For audible warnings, select the output device from the drop-down list. Click Test to verify the output.

File View Tools Help

& B om Normal Operation
@ o Workstation Configuration
4 Aarm Config
General . -
Emiiznsais “ ﬁ Options for L@ti-View audio output

T fiiios & Printing =
. g
e R — -
é Fire Configuration = Monitors
(@ Workstation Config 2 Aarmms

@ Language

% Event Log

« License

Logged on as: Administratar Workstation ID; box01a Onine 5/22/2020 2:31:00 PM
1 I
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Monitors

Use this page to change or confirm the L@ti-View monitor settings. Select Split Screen and move the slider to
control how much of the available monitor screen width is used by L@ti-View.

Ele Yiew Tools Help

& Fom Normal Operation
© wax Workstation Configuration
£ Aarm Config
Aorm status # General )
3 — Options for L@fi-View monitors
F1 Archiving # Printing
Monitors:
& Fre
% Sound
Accaunt M t
&5 Account Manas gement =] T
@ Frre Configuration = Monitors - -
iip made
© Workstation Confi A Alarms 7] Split Screen

@® Language
05 Event Log

« License

Logged on as: Administrator Workstation ID: box01a Orline 5/22/2020 3:26:00 PM

Alarms

Use this page to configure the L@ti-View alarms. Alarms are organized in order of priority and Alarm labels and
colors can be edited by name and color.

Fle View Tools Help

@ F & & Normal Operation
@ wox Workstation Configuration
/' larm Config
25 A
- e ,f ! Set-up the alarms and audible alerts.
& Printing
Alarm Labels and Colors
% Sound
U Lowest Priority | Normal ] ( ]
~ Monitors
Info ]
) ( ] a—
Trouble ( ] c
B Lonuoce ' =
Off ( )
2% Event Log [omne ] ¢ ) ¢
— [(comms Trousle ] ) C
B —
 config Mismatch ] ] c
[(cause and Efect | o c
[ supenisory | .
(securiy ) ommm c
[Test | ommm c
(1mpiict Disablement | . c
[ Disabtement | . c
[ Awitary ] o c
(Pre-Atam | oI C
[Fre | o C
Highest Priorty | Carbon Monoide | ol C
ResetAll G
Audible Alerts
& Show settings for. [Normal -
File:

Logged on as: Administrator Workstation ID: box01a Onine 5/22/2020 3:30:00 PM
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1. Click in the field to rename an alarm label.
2. Click on a color swatch to open the Select Color window.

The alarm color can be changed by using the palette of basic colors, by selecting from the color picker, or
entering specific numerical values. Any generated colors can be added to the custom colors palette.

Audible Alerts

Audible alerts can be assigned to alarm events by locating the desired .wav audio file. The Deadband (sound off)
and Interval (sound on) periods can be set in milliseconds (ms) by entering values in the relevant boxes. Audible
Alerts can be previewed by clicking the preview button.

Language

Import and assign language packs relevant to the country or base of operations. Language files must be the *.qm
file type. L@ti-View will be supplied with a default language for the region or country of first use, and additional
languages can be purchased on request. Contact the local distributor or sales person for more information.

File View Tools Help

A ] Nermal Operation
9 max Workstation Configuration
B MarmConfig
Alorm Status % General
Set active language and install new language packs.
B acivig & Printing
Py . Language Settings
% Sound
£Account Management Installed language packs
@ Fire Configuration & Monitors Default languags
@ Workstation Config A Aarms English (UnitedStates) Active language pack: English (United States)
@ Language

2% Event Log

« License

Import Language Pack

Select File:

Assign Language and Terrary: | Abkhazian ) |

Logged on as: Administrator Workstation ID: box01a Online 5/22/2020 3:31:00 PM
1 1

To import a language pack,

Save the language pack file (*.gm) into the Languages folder in the chosen directory.
From Workstation Config > Language, click Browse.

Find and select the desired language pack file and click Open.

Use the drop-down boxes to select the appropriate language and region.

Click Import and follow the instructions for activating a language pack.

a s wbd =

To activate a language pack,

1. From Workstation Config > Language, confirm that the required language is installed.
2. Select the desired language and click Activate Language Pack.

To remove a language pack,

Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
L@ti-View Installation and Configuration Guide Page 85



System Configuration Menu '.O HOCKHIKI

NOTE The default language cannot be uninstalled.

1. From Workstation Config > Language, select the desired language.
2. Click Remove Language Pack.

Event Log

The Event Log page is used to configure and schedule the archiving of events. By default, archive events are
saved on the workstation, typically at: C:/users/<username>/documents/L@tiView_archive/alarmeventlog. If
necessary, the archive location can be changed by clicking Change... and specifying another location.

Archive items are retained for the period specified, selected from the ‘Archive items older than’ option.

File View Tools Help

& B S & MNormal Operation
® Workstation Configuration
# alarm Config
3
£ General
P E" Configure archive location and schedule
G g & Printing
Archiving
& Frre
% Sound N
PR 7 Acchive root location [c @ti-View._
@ Fire Configuration = Monitors
e v
L Alarms
& Language
15 Event Log
« License
Logged on as: Administrator Workstation ID: box01a Orline 5/22/2020 3:34:00 PM
License

This page is used to check the dongle’s license details.

IMPORTANT! L@ti-View cannot be started without a valid dongle license.

File View Tools Help
& @@ Nermal Operation

Workstation Configuration

o
£ General
. Check product license status.
& Printing
License Information
% Sound
% Licensestatus: | Valig ]
= Montors
Product Variant Standard
~——| | )
Number of Panels: | 128
@ Language [ ]

% Event Log

« License

Logged on as: Administrator Workstation ID: box01a Orline 5/22/2020 3:35:00 PM
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APPENDIX A: KEYBOARD SHORTCUTS

These are the most useful keyboard shortcuts, but other Windows key combinations may also work. Some of
these key combinations are restricted to Editor mode.

All Modes

Alt-F Opens the File menu

Alt-F, X Opens the Exit dialog

Alt-[F4] Closes the active window

Alt-H Opens the Help menu

Alt-H, A Opens the ‘About L@ti-View’ window
Alt-H, Q Opens The Quick Guide in Foxit Reader
Alt-H, U Opens The User Manual in Foxit Reader
Alt-V Opens the View menu

Alt-V, S Save Settings

Alt-Tab Tab through applications (useful when L@ti-View is in front of other windows)
[Del] Delete selected items

[Esc] Closes the currently open dialog

[F3] Opens the Search window

[F5] Show / Hide Main GUI

Windows + L Lock the screen (prevents logging out or closing L@ti-View)
Windows + M Minimize all windows

Ctrl-A Select All

Ctrl-A, Del Delete All Selected items

Ctrl-C Copy the selected item

Ctrl-G Group the selected items

Ctrl-Shift, G Ungroup the selected items

Ctrl-L Lock the selected items

Ctrl-Shift, L Unlock all items

Ctrl-V Paste the last copied item

Ctrl-S Save Settings

Ctrl-X Cut the selected item

Ctrl-Y Redo the last Undo

Ctrl-Z Undo the last change

Ctrl-Left Click Add to a selection

Ctrl-Page Up Send to front

Ctrl-Page Down Send to back

Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
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All Modes

Page Up Send forward

Page Down Send backward

Alt-Up arrow Align top

Alt-V Align vertical centers
Alt-C Align horizontal centers
Alt-Down arrow Align bottom

Alt-Left arrow Align left

Alt-Right arrow Align right

Alt-Shift + Up arrow Distribute vertically
Alt-Shift + Left arrow Distribute horizontally

Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
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APPENDIX B: MANAGE GROUPS GLOSSARY

Default User Group permissions follow the rules below, although users can add additional customized groups if
required. Individual users can belong to multiple groups.

Administrators Users who administer the L@ti-View system and its components

Maintainers Users who maintain the L@ti-View system and its components

Managers Users who supervise Operators, but with additional powers

Operators Ordinary users of the system, dealing with the day-to-day operation and alerts
ClearAlarmsGroup Users who can clear alarms

ClearHardAlarmsGroup Users who can clear ‘hard’ alarms
EnableDisableAlertsGroup Users who can enable and disable alarm reporting

<Add Group Name> User defined additional groups

Hochiki America Corporation Version 1.00 | May 2020 | MAN-1443HA
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Manage Tokens Menu

The Tokens listed below have checkboxes that allow authorized users to assign or remove permissions from
individual system group names (see above) when they are installed. They can also be filtered to show the
assigned items only.

Selecting the top-level box for each token selects every component. Selecting and deselecting the top-level box
deselects everything. Expanding the group allows the user to select or deselect individual components in that
group.

NOTE Unavailable tokens are denoted by ‘TBD’ at the top level (in software), and their listed components are
currently unavailable (although selectable). L@ti-View is supplied with many items selected by default, even if that
option is not available. These selections are suggestions only, and are intended to be used as a starting point for
further editing.

2D GUI TBD Adds/Removes full access to the 2D GUI functions

2D GUI 2D GUI Editor Allows the user to launch the 2D Editor

2D GUI 2D GUI Project Settings Allows the user to change the project settings

2D GUI 2D GUI Symbol Library Allows access to the symbol library

2D GUI Edit 2D GUI System Symbols Allows the user to change the system symbol library

ACS TBD Adds/Removes full access to the ACS functions

o PUSNEp—— Allows the user access to the basic Access Control System Functions. Several functions require additional
permissions.

Administration ~ Database Management Editing Allows the user to modify the database management schedules

Administration ~ User Permissions GUI Allows the user to access the User Permissions GUI

Allows the user access to the database management schedules, where the routine (scheduled) archival and clean
Administration Database Management GUI
up of system databases is controlled

Administration ~ Account Management GUI Allows users access to the Account Management GUI

Allows the user access to the alarm configuration tables, where the behavior of individual alarms or groups of
Administration  Alarm Configuration GUI
alarms can be tailored to match site requirements

Administration Group point permissions Allows Group point permissions to be managed

Administration Adds/Removes full access to the Administration functions

Administration Per-user permissions Allows permissions to be set on a per-user basis, in addition to being granted to groups

BMS TBD Adds/Removes full access to the BMS functions

BMS Building Management GUI Allows the user access to the basic Building Management System GUI

CCTV Load Monitor Layout Allows the user to load a previously saved CCTV monitor setup

CCTV Tracker Mode Allows the user access to CCTV tracker mode

CCTV Save Monitor Layout Allows the user to save the current CCTV monitor setup for later recall
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CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

CCTV

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Play Sequences

CCTV PA Integration
Modify Monitor Layout
Shared Sequence Editing
User Sequence Editing
Full Sequence Editing
Edit Sequence

Full screen/ Split screen

Cancel Primary CCTV Alarm Event

TBD

CCTVGUI

Full Camera Access

Full Monitor Access
Delete Shared Sequences

Create Shared Sequence

Cancel all CCTV Alarm Events

Delete Any Sequence

Delete Monitor Layout
CCTV Coverage Mode
Maintenance Log

Zone Certificates

Fire Mode

Acknowledge Events
Manual Evacuation
Acknowledge Fire Events
Operational Zone Strategies
Print Procedures

Reset Fire Devices

Fire System Schematics
Silence Fire Device
Historical Events
Simulate Fire

System Information Page
Test Fire Zone

Fire GUI

Reception Points
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Allows the user to recall and play back a previously saved CCTV sequence (either personal or shared)
Allows the user to trigger PA announcements to the zone covered by a given CCTV camera view
Allows the user to save the current CCTV monitor setup for later recall, overwriting an existing named setup
Allows the user to save changes to shared CCTV sequences

Allows the user to save changes to their own personal CCTV sequences

Allows the user to save changes to any CCTV sequence

Allows the user access to the CCTV Sequence Editor

Allows the user to change a CCTV Monitor between full screen or quad screen modes

Allows the user to all alarm events from a CCTV alarm monitor

Adds/Removes full access to the CCTV functions

Allows the user access to the basic CCTV functions. Several functions require additional permissions.
Allows the user to view all CCTV cameras

Allows the user to control all CCTV displays associated with their current workstation

Allows the user to delete shared CCTV sequences

Allows the user to create new shared CCTV Sequences

Allows the user to delete the current alarm event from a CCTV alarm monitor

Allows the user to delete any CCTV sequence, including shared sequences and personal sequences created by

other users

Allows the user to delete saved monitor setups

Allows the user access to CCTV coverage mode

Allows the user to view the maintenance logs of the Fire System

Allows the user to view the stored certificates (documents) for zone testing on the Fire System
Allows the user access to Fire Mode in the 2D GUI

Allows the user to acknowledge general events

Allows the user to manually evacuate zones from the GUI

Allows the user to acknowledge fire events on the Fire System itself from the GUI

Allows the user to view the stored Operational Zone Strategy documents within the Fire GUI
Allows the user to send stored documents to the printer from the onscreen document viewer
Allows the user to reset equipment on the Fire System (usually the panels) from the GUI

Allows the user to view the configured schematic pages in the Fire GUI

Allows the user to silence the alarms on a device (usually a panel) in the Fire System from the GUI
Allows the user to view historical events on the Fire System

Allows the user to trigger simulated fires, if this function is supported by the Fire Alarm System
Allows the user to access system information in the Fire GUI

Allows the user to access the Test Zone function

Allows the user access to the basic Fire Management GUI. Many functions require additional permissions.

Allows the user to view the stored reception points in the Fire GUI
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Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

Fire

General

General

General

General

General

General

General

General

General

General

General

General

General

General

General

Silenced Buzzer

Find Mode

Fire System Topology View
TBD

Fire Maintenance Functions
Operational Procedures
Generate Reports

View Active Events

View Active Fires

View All Fire Management Info

View Imported Diagrams
Output Control
Poll Analog Value

Manual Refresh

Enable and Disable Equipment

Enable and Disable Zones
Evacuation Strategy GUI
Export Tables

Cause and Effect Strategy GUI
Save Subsystem Filter
Select Mode

Local Alert Volume Control
Suppress Alarm

Change Password

Alarm unacknowledgement
Unsuppress Alarm

Save Column Widths

Export tables to CSV

Pause Alarm History Updates
General Table Write Access
Exit GUI

Delete Subsystem Filter
Operator Alarms Only

Clear Alarm Caches
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Allows the user to silence the buzzer on a device (usually a panel) in the Fire System from the GUI
Allows the user to place a device into Find Mode and remove it from that mode.

Allows the user to view a graphical tree of the Fire System devices in their logical hierarchy
Adds/Removes full access to the Fire functions

Allows the user to access the Maintenance pages within the Fire GUI

Allows the user to view the stored Operational Procedure documents within the Fire GUI

Allows the user to generate reports from tables in the GUI

Allows the user to view all active events on the Fire System

Allows the user to view the list of active fire events on the Fire System

Allows the user to access all fire management information pages, the list of active fire events, and all strategy and

policy pages

Allows the user to view the imported evacuation policy diagrams (as pdfs)

Allows the user to set the state of contacts (or digital outputs) in the Fire System if these have been configured
Allows the user to poll an analog value from a device

Allows the user to trigger a discrete read from a device

Allows the user to enable and disable fire devices within the Fire System. This is distinct from disabling them only

within the GUI.

Allows the user to enable and disable entire zones within the Fire System, if the system supports this operation
Allows the user to view the installed Zonal Evacuation strategies

Allows the user to export the data from tables in the Fire GUI to a file

Allows the user to view the installed Cause and Effect strategies

Allows the user to save a selected filter set of subsystems in the main alarm list GUI for later recall
Allows the user to access Select Mode in the 2D GUI

Allows the user to access the local volume control for audible alerts generated by the GUI

Allows the user to suppress an alarm from the main alarm list

Allows the user to change their own password through the GUI

Allows the user to ‘unacknowledge’ alarms

Allows the user to ‘unsuppress’ an alarm from the main alarm list

Allows the user to save the current table column widths in the GUI via the save settings menu option
Allows the user to export the text of standard tables in the GUI to .csv files

Allows the user to pause automatic updates of the Alarm History View

Allows the user to edit database tables that do not have a specific access permission

Allows the user to exit from the GUI

Allows the user to delete custom subsystem filters from the main alarm list GUI

If set to >99, the user will not see low-level trouble reports

Allows the user to clear the cache of alarm data, which must be done to enable the ‘Unsuppress Alarm’ option
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General

General

General

General

General
General
IP Networking
IP Networking

L@ti-View

Message Board

Message Board
Message Board

Message Board

Message Board

Message Board

Message Board

PA/VA

PA/VA
PA/VA
PA/VA
PA/VA
PA/VA
PA/VA
PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

Clear Alarms

Enable Alarm Reporting

Disable Alarm Reporting

Clear Hard Trouble s

Alarm acknowledgement
TBD
TBD
Network Monitoring GUI

L@ti-View 2D GUI

Message Board Full Access

Delete Messages
Edit Messages

Post Messages

Message Board GUI

View Messages

TBD

Ad Hoc Message Trigger

Soft Push-To-Talk (Emergency)

Audio Message Support

Zone Overrides Table

Background Music Source Select

Display Brightness Override
Night Volume Override

Soft Push-To-Talk

PA/VA GUI Pin Management

Message Builder Display

Messages

Quick Messages

Message Scheduling

Maximum Scheduled PA Message

Priority
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Allows the user to attempt to clear alarms
Allows the user to re-enable alarm/trouble reporting from items of equipment. (See Disable Alarm Reporting)

Allows the user to disable alarm/trouble reporting from items of equipment. This might be used during maintenance

procedures or in response to spurious (nuisance) troubles.

Allows the user to attempt to clear troubles that have been defined as ‘Hard Troubles’, which are troubles that
require a higher privilege level to clear as a clearance attempt may have particular side effects that must be

understood

Allows the user to acknowledge alarms

Adds/Removes full access to the General functions
Adds/Removes full access to the IP Network functions
Allows basic access to IP Network monitoring functions
Allows the user access to the L@ti-View self-monitoring GUI

Grants the user all permissions within the message board GUI. (Has the same effect as ticking all the individual

permissions in this section.)

Allows the user to delete posted messages

Allows the user to edit posted messages

Allows the user to post new messages on the message board

Allows the user to access the built-in Message Board GUI, where users can leave messages for each other (e.g.

at shift hand-over)
Allows users to read messages
Adds/Removes full access to the Message Board functions

Allows the user to trigger messages (audio or display) from the GUI. Without this permission only live

announcements or scheduled messages can be played.

Allows the user to make emergency live PA announcements from the GUI
Allows the user to select and trigger audio messages

Allows the user to access the Zone Overrides Table

Allows the user to access the BGM source column in Zone Overrides

Allows the user to access the Display Brightness column in Zone Overrides
Allows the user to access the Night Volume Override column in Zone Overrides
Allows the user to make live PA announcements from the GUI

Allows the user to change the security PIN on the PA/VA GUI, if it has been enabled in system configuration
Allows the user to build messages for information display units in the Message Builder

Allows the user to access the ‘Quick Message’ feature, where messages can be triggered from a single dedicated

button

Allows the user access to the PA/VA Scheduler GUI

Allows the user to prioritize scheduled PA messages (100 = maximum priority)
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PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PA/VA

PHP

PHP

PHP

PHP

PHP

PHP

PHP

PHP

PHP

PHP

PHP

PHP

TTS Messages

Display Message Support
Message Builder Audio Messages
Message Management

2D PA/VA Map support (Legacy)
Message Builder

TBD

Advanced PA schedule settings
Edit PA Schedules

Enable / Disable PA schedules
View PA Schedule details
Modify Messages

Listen In Mode

BGM Access

Routine Messages Control (legacy)
PA Coverage Access
Emergency Message Button

PA Access

PA Mute Access

Play Message Button

PA/VA GUI

Zone Group Select Button

PIDS Access

Transfer Help Point Calls

Show All Help Point Call Log Info

Show All Help Point Address Book

Info

Take Help Point Call off Hold
Make Outgoing Help Point Call
Help Point Call Log

Hang up Help Point Call

Help Point Outgoing Call Page
Answer Help Point Calls

Help Point GUI

TBD

Place Help Point Call on Hold
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Allows the user to create and save Text-to-Speech (TTS) messages

Allows the user to select and trigger display messages (e.g. on visual information displays)
Allows the user to build audio messages in the Message Builder

Allows the user access to PA/VA Message Management to record, rename, and delete messages
Allows the user to access the legacy 2D PA map

Allows the user to access the PA/VA Message Builder

Adds/Removes full access to the PA/VA functions

Allows the user to access all of the advanced settings on a PA/VA schedule

Allows the user to edit the details of PA/VA schedules

Allows the user to enable and disable (but not edit) PA/VA schedules

Allows the user to view the details of PA/VA schedules

Allows the user to modify existing audio or display messages

Allows the user to access Listen In Mode in the 2D/3D GUI

Allows the user to control background music (on/off) in the main GUI

Allows the user to access the Routine Messages Suppression column in Zone Overrides

Allows the user to view PA coverage in the main GUI

Allows the user to access the Emergency Message button in the 2D GUI

Allows the user to access PA Mode. If the user also has access to PIDS mode, then the unified PIS mode is used
Allows the user to control PA Mute on/off in the main GUI

Allows the user to access the Play Message button in the 2D GUI

Allows access to basic PA/VA functions. Advanced functions require additional permissions.
Allows the user to access the zone group select buttons in the 2D GUI

Allows the userto access PIDS mode. If the user also has access to PA mode, then the unified PIS mode is used
Allows the user to transfer a help point call to the external line

Allows the user to see all data columns in the help point call log
Allows the user to see all data columns in the help point Address Book

Allows the user to resume a help point call that has been placed on hold

Allows the user to make an outgoing call to a help point

Allows the user to view the help point call log

Allows the user to hang up an incoming help point call, once answered

Allows the user to view the help point outgoing call page (the ‘address book’ of help points)
Allows the user to answer incoming help point calls

Allows access to basic Help Point Functions

Adds/Removes full access to the PHP functions

Allows the user to put a help call on hold
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PHP

PIS

PIS

PIS
Schematics
Schematics
Special
Special
Special
Special
Telephony

Telephony

Telephony

Telephony
Telephony
Telephony
Telephony
Telephony
Voice Recorder
Voice Recorder
Voice Recorder
Voice Recorder

Voice Recorder

Mute Help Point Call

DDU Test Mode

Assign DDU Profile

TBD

TBD

Schematics Page Selection

TBD

Full Control

Message Builder Diagnostic Panel
Message Management Information
Enable Speed Dialler

Address Book Extended View

Make Telephone Calls

Delete Telephony Contact
Add Telephony Contact
Telephony GUI

TBD

Edit Telephony Contact
TBD

Delete Voice Recordings
Play Voice Recordings
Save Voice Recordings

Voice Recording System GUI
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Allows the user to mute/unmute a help point call
Allows the user to put the DDU into test mode
Allows the user to assign a display profile to a Data Display Unit

Adds/Removes full access to the PIS functions

Allows the user to view the drop-down list of schematics in the Schematics GUI
Adds/Removes full access to the Special functions

Allows access to all features and GUls

Allows the user to see the diagnostic panel in the PA/VA Message Builder GUI
Allows the user to see the diagnostic panel in the PA/VA Message Management GUI
Allows the user to access the configurable ‘Speed Dial’ buttons in the Telephony GUI
Allows the user to see all data columns in the Address Book

Allows the user access to the Make Calls page in the Telephony GUI, and thus make calls from the SIP phone

associated with their workstation.

Allows the user to delete contacts from the Telephony Address Book

Allows the user to add new contacts to the Telephony Address Book

Allows the user access to the basic telephony functions. Advanced functions require additional permissions
Adds/Removes full access to the Telephony functions

Allows the user to edit contacts in the Telephony Address Book

Adds/Removes full access to the Voice Recorder functions

Allows the user to delete recordings made by the Voice Recorder System

Allows the user to play recordings made by the Voice Recorder System

Allows the user to save recordings made by the Voice Recorder System to an external or networked drive

Allows the user access to the Voice Recording System functions
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APPENDIX C: TROUBLESHOOTING

L@ti-View will not start.

The screen does not appear right.

The desired panel cannot be located.

L@ti-View closed unexpectedly.

The wrong symbols are displaying in the Symbol

Library.

Previously deleted symbols are now duplicated.

L@ti-View hangs during symbol loading.

Hochiki America Corporation
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No dongle, or dongle license is
out of date.

L@ti-View is not compatible
with the OS.

New installation

Changes were made and
saved by the last user.

Changes were made and not
saved.

Panels docked in the same
space will be stacked up.

The Bootstrap CMD window
was closed by mistake and
unsaved changes were lost.

This action cannot be reversed.

The Symbols library wasn'’t
refreshed between Delete and
Import.

Make a note of the error
message and close L@ti-View
by closing the CMD window.

Fit a current dongle before launching
L@ti-View.

Install L@ti-View on a Windows 7
system or later.

Either load a project or create and save
a new one.

Load a previously saved version and
save it.

Make the changes again and save
them.

Select the desired panel on the tab at
the bottom of the dock area.

Restart L@ti-View. Save regularly
during edits. Save versions if making a
lot of changes.

Import fresh symbols and their
ancillaries from the PC or workstation.

Restart L@ti-View without saving the
current changes.

Load an earlier saved version.

Close the Symbols Library between
tasks.

Manually delete the offending image
file from the directory folder and retry
loading the L@ti-View project.
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2

2D

Two Dimensional on the x-y axis

3

3D

Three Dimensional on the x-y-z axis

A

ACID

Access Control and Intruder Detection

ANS

Ambient Noise Sensor

B

BGM

Background Music

BGU

Break Glass Unit (fire alarm)

BMS

Building Management System

Cc

CAE
Cause and Effect

CIS

Customer Information Sensor
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Csv
Comma Separated Values; the .csv file type allows files to be imported into columns and
rows in spreadsheets and databases

D

DDU
Data Display Unit

DIP

Dynamic IP address

E

End-Of-Line Device (EOLD)
An electronic component physically installed as the furthest device from the control panel,;
whose presence on the circuit is used to monitor the integrity of the circuit.

EOL
End Of Line (e.g. alarms, CCTV, detectors, sounders, speakers)

EOLR
End-of-Line Resistor

F

FACS

Fire Alarm Control System

FAS
Fire Alarm Control System

G

GUI

Graphical User Interface

GUID

Globally Unique Identifier used to identify equipment on a network
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/10
Input / Output

IP
Internet Provider (networking)

L

LAN
Local Area Network

LLPA
Long Line Public Address

N

NAC
Notification Appliance Circuit. A supervised output circuit that connects horns, strobes,
speakers, etc. to the control panel.

P

PA
Public Address

PIDS

Passenger Information Display System

px

pixel

S

SIP
Static IP Address
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SIP2
Session Initiation Protocol (SIP) is a communications protocol for signalling and controlling
multimedia communication sessions in applications of Internet telephony for voice and
video calls, in private IP telephone systems, as well as in instant messaging over Internet
Protocol (IP) networks.

SLC
Signaling Line Circuit. A Signaling Line Circuit (SLC) carries data to and from the field
devices for the fire alarm system, and also carries power from the control panel to the

devices.

SMS
Station and building Management System / Site Management System

SOP
Site (or Standard) Operating Procedures

T

TCP/IP
Transmission Control Protocol/Internet Protocol

U

UAC
User Account Control (Microsoft)

X

x-y axis
x -y refers to screen pixel coordinates based on the available screen resolution (e.g. 1920 x
1080). X = the horizontal screen axis drawn left-to-right, and Y = the vertical screen axis
drawn top-to-bottom. A VDU’s nominal point of origin (x =0, y = 0) is positioned at the top
left of the screen, so a screen item’s nominal point of origin might be stipulated (in code) as
[x =x+100;y =y + 100].
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Z

z-axis
z refers to a virtual axis running tangentially to the x-y axes; x-y-z coordinates can be used
to create 3D objects that can pan, tilt, and rotate in virtual 3-dimensional space.

z-order
Incident priorities are allocated to default layers arranged, in descending order, on the z-
axis. In other words, the highest current priority (e.g. Fire) cannot be obscured by items of
lower priority.

z-index
Incident priorities are allocated to default layers arranged, in descending order, on the z-
axis. In other words, the highest current priority (e.g. Fire) cannot be obscured by items of
lower priority.
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